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Въведение 

 

Настоящият документ представлява Ръководство за работа с подсистема „Микроданни” 

на Информационна система „Бизнес статистика”.  

ИС „Бизнес статистика” е създадена по поръчка на Националния статистически институт 

с цел автоматизиране на процеса по попълването, валидирането и предаването на 

задължителните годишни отчети на предприятията в Република България. 

 

Чрез модула за въвеждане на отчети потребителите на системата (респонденти, 

счетоводни къщи и служители на НСИ) могат да извършват въвеждане, редактиране, 

валидиране и приключване на годишни отчети: 

 Въвеждане и редактиране на годишни отчети: 

 Търсене и извличане на въведени годишни отчети; 

 Редактиране и съхраняване на данните на отделна справка от 

комплекта документи; 

 Валидиране на отделна справка от комплекта документи; 

 Изтриване на въведена справка от комплекта документи. 

 Приключване (обработване) на годишен отчет 

 Логически контрол и обработване на годишен отчет; 

 Сторниране на обработката на годишен отчет; 

 Анулиране и де-анулиране на годишен отчет. 

 

ИС „Бизнес статистика” е реализирана като централизирана публична Web-базирана 

система, инсталирана и обслужвана от НСИ. Системата е достъпна в Интернет 

пространството през Web-страницата на НСИ и на адрес https://isbs.nsi.bg 

 

ИС „Бизнес статистика” функционира целогодишно и позволява достъп на външни 

потребители (респонденти и счетоводни къщи) 24 часа в денонощието. Въведените данни 

от отчетите се съхраняват в защитена централизирана база данни, обслужвана от сървър в 

сградата на НСИ. Системата позволява отчетите да бъдат въвеждани на части и да бъдат 

редактирани многократно до края на съответния срок за подаване на отчети. След края на 

този срок достъпът на респондентите и счетоводните къщи до отчетите е само за четене. 

 

https://isbs.nsi.bg/
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1. Предварителни изисквания и настройки 

Модулът за въвеждане на отчети на ИС „Бизнес статистика” е публично достъпен през 

Интернет. За да можете да работите със системата, трябва ползвате валиден цифров 

сертификат (виж 1.11 „Изискване за ползване на цифров сертификат”), а за нейното 

нормално функциониране е необходимо работната станция, от която ще работите,  да има 

инсталирани следните софтуерни продукти: 

1) Интернет браузър (един от следните): 

 Microsoft Internet Explorer
1
 7, 8, 9, 10 или 11; 

 Mozilla Firefox 2.0 или по-нов; 

 Google Chrome. 

2) Adobe Reader 9 или по-нов
2
 

Тези софтуерни продукти са безплатни и може да ги изтеглите от сайтовете на техните 

производители. В началната страница на потребителското приложения на ИС „Бизнес 

статистика“ има препратки към сайтовете, откъдето можете да ги изтеглите. 

В случай, че разполагате с версии на продуктите, които са по-стари от необходимите, 

системата няма да работи коректно. Системата извършва проверка на Интернет браузъра 

още при стартиране на началната страница на приложението и сигнализира със 

съобщение, ако браузърът или неговата версия не са подходящи. 

В случай, че необходимите продукти са инсталирани на Вашата работна станция, е 

необходимо да проверите допълнително някои техни настройки преди да започнете 

работа със системата (виж подточките по-долу). 

 

Сървърът на ИС „Бизнес статистика” удостоверява своята идентичност пред браузърите 

на потребителите чрез цифров сертификат, издаден от лицензирания Доставчик на 

удостоверителни услуги (ДУУ) „Банксервиз” АД. За да може Вашият браузър да провери 

валидността на този сертификат, е необходимо да сте дефинирали във Вашия браузър 

„Банксервиз” АД като доверен ДУУ (т.е.  като Trusted Certificate Authority), като за целта 

трябва да сте инсталирали в браузъра удостоверителните вериги на услугата B-Trust на 

„Банксервиз” АД (за подробности виж в подточките по-долу).  

                                                 

 
1
 64-битовите версии на MS Internet Explorer 8 и 9 не се поддържат, тъй като PDF-plugin-ът на Adobe Reader 

не работи в MS Internet Explorer 64-bit. Вместо това, ако браузърът Ви е MS Internet Explorer 8 или 9, 

ползвайте 32-битовата версия на браузъра. При Internet Explorer 10 и 11 такъв проблем няма. 

 
2
 Вместо Adobe Reader 9 (или по-нов) може да ползвате също Adobe Acrobat 9 (или по-нов), ако разполагате 

с този продукт, но трябва да имате предвид, че Adobe Acrobat е комерсиален продукт и ползването му 

изисква да имате закупен съответен лиценз, за разлика от Adobe Reader, който е безплатен продукт. 

Системата няма да работи коректно с друг PDF viewer (като например Foxit Reader). 
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1.1 Настройки на Microsoft Internet Explorer (на английски) 

1) Уверете се, че в security-настройките на Internet Explorer са разрешени следните 

опции: 

 В група „ActiveX controls and plug-ins”: 

 Binary and script behaviors: Enabled 

 Run ActiveX controls and plug-ins: Enabled 

 Script ActiveX controls marked safe for scripting: Enabled 

 В група „Downloads”: 

 File download: Enabled 

 В група „Miscellaneous”: 

 Userdata persistence: Enabled 

 В група „Scripting”: 

 Active scripting: Enabled 

 За целта: 

 Влезте в меню Tools > Internet Options... 

 Изберете тематичната страница Security в горния край на диалоговия 

прозорец 

 Изберете security-зоната, в която работи ИС „Бизнес статистика” (по 

подразбиране зоната е Internet, ако изрично не сте включили адреса 

isbs.nsi.bg в друга зона); 

 Натиснете бутона Custom Level... 

 Намерете в списъка настройките, изброени по-горе и се уверете, че за 

всички тях е включена опцията Enable;  

 

2) Уверете се, че сте изключили опцията „Pop-up Blocker”, т.е. трябва да 

разрешите приложението да отваря допълнителни прозорци. По подразбиране 

тази опция е включена. (Можете да настроите опцията да се изключва само за 

сайта на ИС „Бизнес статистика”). За целта направете едно от следните: 

 От меню Tools > Pop-up Blocker изберете Turn off Pop-up Blocker или 

 От меню Tools > Pop-up Blocker изберете Pop-up Blocker Settings и 

въведете изключение, което да разрешава приложението да отваря 

допълнителни прозорци в сайта на ИС „Бизнес статистика” 

(isbs.nsi.bg). 

3) Уверете се, че имате включена опция „Use SSL 3.0” в допълнителните 

настройки на браузъра. За целта; 

 Влезте в меню Tools > Internet Options... 

 Изберете тематичната страница Advanced в горния край 

 Потърсете в списъка елемента Use SSL 3.0 и го включете, ако е изключен; 
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4) Уверете се, че e включена опцията „Use HTTP 1.1” в допълнителните 

настройки на браузъра. За целта: 

 Влезте в меню Tools > Internet Options... 

 Изберете тематичната страница Advanced в горния край 

 Потърсете в списъка елементите Use HTTP 1.1 и Use HTTP 1.1 through 

proxy connections и ги включете, ако са изключени. 

5) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)
3
, ако все още не е дефиниран като такъв във Вашия браузър. 

За целта: 

 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 

при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard; 

 Извикайте в браузъра URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 

при което ще се извърши download на root-сертификата на услугата B-Trust 

на „Банксервиз” АД, чрез който е подписан оперативният сертификат от 

предната стъпка; 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard, като в страницата „Certificate 

Store“ укажете „Place all certificates in the following store” и в полето 

„Certificate Store” укажете „Trusted Root Certification Authorities”.  

В случай, че имате проблеми със системата при работа с браузър MS Internet Explorer, 

въпреки че сте настроили браузъра съгласно нашите инструкции, върнете фабричните 

настройки на браузъра, след което повторете настройката, описана по-горе. Връщане на 

фабричните настройки на браузъра можете на направите по следния начин: 

 Влезте в меню Tools > Internet Options... 

 Изберете тематичната страница Advanced в горния край 

 Натиснете бутона Reset… в долната част на прозореца. 

Важно: При MS Internet Explorer 8 и 9 има проблеми при 64-битовата версия на браусъра, изразяващи 

се в невъзможност за отваряне на тези справки в отчетите, които са реализирани като PDF-форми. 

Причината е в PDF-plugin-а на Adobe Reader, който е 32-битов и не работи в 64-битовата версия на MS 

Internet Explorer 8 и 9. При Internet Explorer 10 и 11 такъв проблем няма. 

Затова, ако операционната Ви система е 64-битова и браузърът Ви е MS Internet Explorer 8 или 9, 

ползвайте 32-битовата версия на браузъра, която можете да стартирате от: 

C:\Program Files (x86)\Internet Explorer\iexplore.exe 

                                                 

 
3
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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1.2 Настройки на Microsoft Internet Explorer (на български) 

1) Уверете се, че в security-настройките на Internet Explorer са разрешени следните 

опции: 

 В група „ActiveX контроли и добавки”: 

 Двоични и скриптови поведения: Разрешаване 

 Изпълнявай ActiveX контролите и добавките: Разрешаване 

 Скриптови ActiveX контроли, маркирани като безопасни за 

използване в скриптове: Разрешаване 

 В група „Изтегляния”: 

 Изтегляне на файл: Разрешаване 

 В група „Изготвяне на скрипт”: 

 Активно изготвяне на скрипт: Разрешаване 

 В група „Разни”: 

 Запазване на потребителските данни: Разрешаване 

 За целта: 

 Влезте в меню Инструменти > Опции за интернет 

 Изберете тематичната страница Защита в горния край на диалоговия 

прозорец 

 Изберете security-зоната, в която работи ИС „Бизнес статистика” (по 

подразбиране зоната е Интернет, ако изрично не сте включили адреса 

isbs.nsi.bg в друга зона); 

 Натиснете бутона Ниво по избор... 

 Намерете в списъка настройките, изброени по-горе и се уверете, че за 

всички тях е включена опцията Разрешаване;  

2) Уверете се, че сте изключили опцията „Блокиране на изскачащи прозорци”, т.е. 

трябва да разрешите приложението да отваря допълнителни прозорци. По 

подразбиране тази опция е включена. (Можете да настроите опцията да се 

изключва само за сайта на ИС „Бизнес статистика”). За целта направете едно от 

следните: 

 От меню Инструменти > Блокиране на изскачащите прозорци изберете 

Изключи блокирането на изскачащи прозорци или 

 От меню Инструменти > Блокиране на изскачащите прозорци изберете 

Настройки на блокирането на изскачащи прозорци и въведете 

изключение, което да разрешава приложението да отваря допълнителни 

прозорци в сайта на ИС „Бизнес статистика” (isbs.nsi.bg). 

3) Уверете се, че имате включена опция „Използвай SSL 3.0” в допълнителните 

настройки на браузъра. За целта; 

 Влезте в меню Инструменти > Опции за интернет 

 Изберете тематичната страница Разширени в горния край 

 Потърсете в списъка елемента Използвай SSL 3.0 и го включете, ако е 

изключен 
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4) Уверете се, че e включена опцията „Използвай HTTP 1.1” в допълнителните 

настройки на браузъра. За целта: 

 Влезте в меню Инструменти > Опции за интернет 

 Изберете тематичната страница Разширени в горния край 

 Потърсете в списъка елементите Използвай HTTP 1.1 и Използвай HTTP 1.1 

през връзки с прокси сървър и ги включете, ако са изключени. 

5) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни услуги 

(ДУУ)
4
, ако все още не е дефиниран като такъв във Вашия браузър. 

За целта: 

 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Инсталиране на сертификат… и 

преминете през стъпките на Съветник за инсталиране на сертификати; 

 Извикайте в браузъра URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 
при което ще се извърши download на root-сертификата на услугата B-Trust на 

„Банксервиз” АД, чрез който е подписан оперативният сертификат от предната 

стъпка; 

 Отворете сертификата, натиснете бутона Инсталиране на сертификат… и 

преминете през стъпките на Съветник за инсталиране на сертификати, 

като в страницата „Хранилище за сертификати“ укажете „Поставяй всички 

сертификати в следното хранилище” и в полето „Хранилище за 

сертификати” укажете „Надеждни главни сертифициращи органи”.  

В случай, че имате проблеми със системата при работа с браузър MS Internet Explorer, 

въпреки че сте настроили браузъра съгласно нашите инструкции, върнете фабричните 

настройки на браузъра, след което повторете настройката, описана по-горе. Връщане на 

фабричните настройки на браузъра можете на направите по следния начин: 

 Влезте в меню Инструменти > Опции за интернет. 

 Изберете тематичната страница Разширени в горния край 

 Натиснете бутона Начално състояние… в долната част на прозореца. 

Важно: При MS Internet Explorer 8 и 9 има проблеми при 64-битовата версия на браусъра, изразяващи 

се в невъзможност за отваряне на тези справки в отчетите, които са реализирани като PDF-форми. 

Причината е в PDF-plugin-а на Adobe Reader, който е 32-битов и не работи в 64-битовата версия на MS 

Internet Explorer 8 и 9. При Internet Explorer 10 и 11 такъв проблем няма. 

Затова, ако операционната Ви система е 64-битова и браузърът Ви е MS Internet Explorer 8 или 9, 

ползвайте 32-битовата версия на браузъра, която можете да стартирате от: 

C:\Program Files (x86)\Internet Explorer\iexplore.exe 

                                                 

 
4
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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1.3 Настройки на Mozilla Firefox (на английски) 

1) Уверете се, че сте разрешили изпълнението на JavaScript в браузъра. За целта: 

 В адресния ред напишете about:config и натиснете клавиша <Enter> 

 Ако бъде изведено предупредително съобщение, натиснете в него бутона 

„I’ll be carefull!”  

 В полето за търсене извършете търсене за javascript.enabled 

 Включете преференцията javascript.enabled, ако е изключена (за целта 

направете десен клик с мишката върху нея и изберете „Togle” или пък 

просто извършете двоен клик с мишката върху преференцията), за да 

стане нейната стойност „true” 

2) Уверете се, че сте изключили опцията „Pop-up Blocker”, т.е. трябва да 

разрешите приложението да отваря допълнителни прозорци. По подразбиране 

тази опция е включена. (Можете да настроите опцията да се изключва само за 

сайта на ИС „Бизнес статистика”). За целта: 

 Влезте в меню Tools > Options... 

 Изберете тематичната страница Content в горния край 

 Уверете се, че е изключена опцията Block popup windows 

или 

 От същото място чрез бутона Exceptions въведете изключение, което да 

разрешава приложението да отваря допълнителни прозорци в сайта на ИС 

„Бизнес статистика” (isbs.nsi.bg). 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)
5
, ако все още не е дефиниран като такъв във Вашия браузър. За 

целта извършете следните действия: 

 Извикайте в Mozilla Firefox URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 

при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” АД (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата в Mozilla Firefox, задайте предназначението му 

както е показано на долната картинка и натиснете бутона „OK”: 

 

                                                 

 
5
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
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Фиг. 1 Дефиниране на „Банксервиз” АД в Mozilla Firefox 
като доверен удостоверител на сървърни сертификати 

4) Настройте браузъра да отваря PDF-документите чрез Adobe Reader (или Adobe 

Acrobat) вътре в екран на браузъра, а не във външен прозорец. За целта: 

 Влезте в меню Tools > Options... 

 Изберете тематичната страница Applications в горния край; 

 За типа „Portable Document Format (PDF)” и за типовете, съдържащи в 

името си „Adobe Acrobat“, задайте „Use Adobe Acrobat (In Firefox)”: 

 
Фиг. 2 Настройване на PDF-документите да се отварят от Adobe Reader вътре в Mozilla Firefox 
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1.4 Настройки на Mozilla Firefox (на български) 

1) Уверете се, че сте разрешили изпълнението на JavaScript в браузъра. За целта: 

 В адресния ред напишете about:config и натиснете клавиша <Enter> 

 Ако бъде изведено предупредително съобщение, натиснете в него бутона 

„Ще бъда внимателен, обещавам!”  

 В полето за търсене извършете търсене за javascript.enabled 

 Включете преференцията javascript.enabled, ако е изключена (за целта 

направете десен клик с мишката върху нея и изберете „Превключване” 

или пък просто извършете двоен клик с мишката върху преференцията), 

за да стане нейната стойност „true” 

2) Уверете се, че сте изключили опцията „Блокиране на изскачащи прозорци”, т.е. 

трябва да разрешите приложението да отваря допълнителни прозорци. По 

подразбиране тази опция е включена. (Можете да настроите опцията да се 

изключва само за сайта на ИС „Бизнес статистика”). За целта: 

 Влезте в меню Инструменти > Настройки... 

 Изберете тематичната страница Съдържание в горния край 

 Уверете се, че е изключена опцията Блокиране на изскачащи прозорци 

или 

 От същото място чрез бутона Изключения въведете изключение, което да 

разрешава приложението да отваря допълнителни прозорци в сайта на ИС 

„Бизнес статистика” (isbs.nsi.bg). 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)
6
, ако все още не е дефиниран като такъв във Вашия браузър. За 

целта извършете следните действия: 

 Извикайте в Mozilla Firefox URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 

при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” АД (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата в Mozilla Firefox, задайте предназначението му 

както е показано на долната картинка и натиснете бутона „Добре”: 

 

                                                 

 
6
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
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Фиг. 3 Дефиниране на „Банксервиз” АД в Mozilla Firefox 
като доверен удостоверител на сървърни сертификати 

4) Настройте браузъра да отваря PDF-документите чрез Adobe Reader (или Adobe 

Acrobat) вътре в екран на браузъра, а не във външен прозорец. За целта: 

 Влезте в меню Инструменти > Настройки... 

 Изберете тематичната страница Приложения в горния край; 

 За типа „Преносим формат за документи (PDF)” и за типовете, 

съдържащи в името си „Adobe Acrobat“, задайте „Използване на Adobe 

Acrobat (в Firefox)”: 

 
Фиг. 4 Настройване на PDF-документите да се отварят от Adobe Reader вътре в Mozilla Firefox 
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1.5 Настройки на Google Chrome (на английски) 

1) Уверете се, че Google Chrome позволява ползване на JavaScript, Pop-ups и Plug-

ins. За целта: 

 Стартирайте Google Chrome и натиснете бутона  (Customize and control 

Google Chrome)  

 Изберете Settings и натиснете link-а Show advanced settings в долната част 

на страницата 

 Натиснете бутона Content Settings, намерете настройките за JavaScript,  Pop-

ups и Plug-ins и проверете дали ползването им е позволено. Ако не е 

позволено, го разрешете за всички сайтове или поне за адрес isbs.nsi.bg 

2) Уверете се, че имате включени опциите Use SSL 3.0, Use HTTP 1.1 и Use HTTP 

1.1 through proxy connections в допълнителните настройки на браузъра. За целта: 

 Натиснете бутона  (Customize and control Google Chrome) 

 Изберете Settings и натиснете link-а Show advanced settings в долната част 

на страницата 

 Натиснете бутона Change proxy settings в секцията Network 

 Изберете тематичната страница Advanced в горния край 

 Потърсете в списъка елементите Use HTTP 1.1, Use HTTP 1.1 through 

proxy connections и Use SSL 3.0 и ги включете, ако са изключени. 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)
7
, ако все още не е дефиниран като такъв във Вашия браузър. За 

целта: 

 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 

при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard; 

 Извикайте в браузъра URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 

при което ще се извърши download на root-сертификата на услугата B-Trust 

на „Банксервиз” АД, чрез който е подписан оперативният сертификат от 

предната стъпка; 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard, като в страницата „Certificate 

Store“ укажете „Place all certificates in the following store” и в полето 

„Certificate Store” укажете „Trusted Root Certification Authorities”. 

                                                 

 
7
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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4) Деактивирайте стандартния Chrome PDF Viewer plug-in, вграден в Google 

Chrome и активирайте Adobe Reader plug-in
8
. За целта: 

 Стартирайте Google Chrome и чрез въвеждане на служебния адрес 

about:plugins в полето за URL активирайте служебната страница за 

настройване на plugin-ите в Google Chrome 

 Намерете в списъка plugin-а Adobe Reader (Adobe PDF Plug-In For Firefox 

and Netscape) и проверете дали той е активен. (Ако plugin-ът не е активен, 

под името му ще има link с име Enable, а ако е активен – името на link-а 

ще е Disable) 

 Ако plugin-ът Adobe Reader не е активен, го активирайте чрез link-а 

Enable под името на plugin-а. При това действие вграденият в браузъра 

plugin Chrome PDF Viewer автоматично ще бъде деактивиран 

 
Фиг. 5 Настройка на plugins в Google Chrome 

                                                 

 
8
 В противен случай няма да можете да отваряте справките, реализирани като PDF-бланки. 
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1.6 Настройки на Google Chrome (на български) 

1) Уверете се, че Google Chrome позволява ползване на JavaScript, Pop-ups 

(Изскачащи прозорци) и Plug-ins (Приставки). За целта: 

 Стартирайте Google Chrome и натиснете бутона  (Персонализиране и 

управление на Google Chrome)  

 Изберете Настройки и натиснете link-а Показване на разширените 

настройки в долната част на страницата 

 Натиснете бутона Настройки за съдържанието, намерете настройките за 

JavaScript, Изскачащи прозорци и Приставки и проверете дали ползването им е 

позволено. Ако не е позволено, го разрешете за всички сайтове или поне за 

адрес isbs.nsi.bg 

2) Уверете се, че имате включени опциите Use SSL 3.0, Use HTTP 1.1 и Use HTTP 1.1 

through proxy connections в допълнителните настройки на браузъра. За целта: 

 Натиснете бутона  (Персонализиране и управление на Google Chrome) 

 Изберете Настройки и натиснете link-а Показване на разширените 

настройки в долната част на страницата 

 Натиснете бутона Промяна на настройките на прокси сървъра в секцията 

Мрежа 

 Изберете тематичната страница Advanced в горния край 

 Потърсете в списъка елементите Use HTTP 1.1, Use HTTP 1.1 through proxy 

connections и Use SSL 3.0 и ги включете, ако са изключени. 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни услуги 

(ДУУ)
9
, ако все още не е дефиниран като такъв във Вашия браузър. За целта: 

 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard; 

 Извикайте в браузъра URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 
при което ще се извърши download на root-сертификата на услугата B-Trust на 

„Банксервиз” АД, чрез който е подписан оперативният сертификат от предната 

стъпка; 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard, като в страницата „Certificate 

Store“ укажете „Place all certificates in the following store” и в полето 

„Certificate Store” укажете „Trusted Root Certification Authorities”. 

                                                 

 
9
 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 

системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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4) Деактивирайте стандартната Chrome PDF Viewer приставка, вградена в Google 

Chrome и активирайте Adobe Reader приставката
10

. За целта: 

 Стартирайте Google Chrome и чрез въвеждане на служебния адрес 

about:plugins в полето за URL активирайте служебната страница за 

настройване на plugin-ите (приставките) в Google Chrome 

 Намерете в списъка plugin-а (приставката) Adobe Reader (Adobe PDF Plug-

In For Firefox and Netscape) и проверете дали той е активен. (Ако plugin-

ът не е активен, под името му ще има link с име Активиране, а ако е 

активен – името на link-а ще е Деактивиране) 

 Ако plugin-ът (приставката) Adobe Reader не е активен, го активирайте 

чрез link-а Активиране под името на plugin-а. При това действие 

вградената в браузъра приставка Chrome PDF Viewer автоматично ще 

бъде деактивирана 

 
Фиг. 6 Настройка на plugins (приствките) в Google Chrome 

                                                 

 
10

 В противен случай няма да можете да отваряте справките, реализирани като PDF-бланки. 
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1.7 Настройки на Google Chrome (стари версии) 

1) Уверете се, че Google Chrome позволява ползване на JavaScript, Pop-ups и Plug-

ins. За целта: 

 Стартирайте Google Chrome и натиснете бутона  (Customize and control 

Google Chrome)  

 Изберете Options и влезте в тематичната страница Under The Bonnet 

 Натиснете бутона Content Settings, намерете настройките за JavaScript,  Pop-

ups и Plug-ins и проверете дали ползването им е позволено. Ако не е 

позволено, го разрешете за всички сайтове или поне за адрес isbs.nsi.bg 

2) Уверете се, че имате включени опциите Use SSL 3.0, Use HTTP 1.1 и Use HTTP 

1.1 through proxy connections в допълнителните настройки на браузъра. За целта: 

 Натиснете бутона  (Customize and control Google Chrome)  

 Изберете Options и влезте в тематичната страница Under The Bonnet 

 Натиснете бутона Change proxy settings 

 Изберете тематичната страница Advanced в горния край 

 Потърсете в списъка елементите Use HTTP 1.1, Use HTTP 1.1 through 

proxy connections и Use SSL 3.0 и ги включете, ако са изключени. 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)
11

, ако все още не е дефиниран като такъв във Вашия браузър. За 

целта: 

 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 

при което ще се извърши download на оперативния сертификат на услугата 

B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 

издавани от „Банксервиз” (с този сертификат е подписан и сървърният 

сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard; 

 Извикайте в браузъра URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 

при което ще се извърши download на root-сертификата на услугата B-Trust 

на „Банксервиз” АД, чрез който е подписан оперативният сертификат от 

предната стъпка; 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 

през стъпките на Certificate Import Wizard, като в страницата „Certificate 

Store“ укажете „Place all certificates in the following store” и в полето 

„Certificate Store” укажете „Trusted Root Certification Authorities”. 
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 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен 

ДУУ), системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 

сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 

системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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4) Деактивирайте стандартния Chrome PDF Viewer plug-in, вграден в Google 

Chrome и активирайте Adobe Acrobat plug-in
12

. За целта: 

 Стартирайте Google Chrome и чрез въвеждане на служебния адрес 

about:plugins в полето за URL активирайте служебната страница за 

настройване на plugin-ите в Google Chrome 

 Намерете в списъка plugin-а Adobe Acrobat (Adobe PDF Plug-In For Firefox 

and Netscape) и проверете дали той е активен. (Ако plugin-ът не е активен, 

под името му ще има link с име Enable, а ако е активен – името на link-а 

ще е Disable) 

 Ако plugin-ът Adobe Acrobat не е активен, го активирайте чрез link-а 

Enable под името на plugin-а. При това действие вграденият в браузъра 

plugin Chrome PDF Viewer автоматично ще бъде деактивиран 

 
Фиг. 7 Настройка на plugins в Google Chrome 

                                                 

 
12

 В противен случай няма да можете да отваряте справките, реализирани като PDF-бланки. 
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1.8 Настройки на Adobe Reader 9 

1) Уверете се, че сте разрешили изпълнението на JavaScript в PDF-форми. За 

целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете JavaScript в списъка в лявата част на диалоговия прозорец  

 Уверете се, че е включена опцията Enable Acrobat JavaScript най-отгоре в 

десния панел. 

 

 
Фиг. 8 Разрешаване на ползване на Javascript в Adobe Reader 9 

Забележка: Ако тази опция е изключена, при първото отваряне на справка от 

отчета, която е разработена като PDF-форма, ще се визуализира съобщение, че 

документът съдържа програмен код, без който няма да се обработи коректно 

електронната форма. В съобщението се съдържа въпрос дали желаете да позволите 

изпълнението на JavaScript. Изберете отговор „Yes”. 
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2) Ако ползвате Enhanced Security в Adobe Reader (т.е. ако е включена опцията 

„Enable Enhanced Security”), добавете адреса isbs.nsi.bg в списъка на 

Privileged Locations, в противен случай PDF-формите на справките в отчетите 

няма да работят. За целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете Security (Enhanced) в списъка в лявата част на прозореца  

 Натиснете бутона Add Host и в отворения диалогов прозорец въведете 

адреса isbs.nsi.bg 

 
Фиг. 9 Дефиниране на isbs.nsi.bg като Privileged Location 

Забележка: Дефинирането на адреса isbs.nsi.bg като Privileged Location не е 

необходимо, ако ползвате браузър MS Internet Explorer, вече сте дефинирали този 

адрес като Trusted Site и в Adobe Reader е включена опцията „Automatically trust 

sites from my Win OS security zones” (виж фигурата по-горе). 

Важно: Ако вместо Adobe Reader (или Adobe Acrobat) ползвате друг PDF viewer (като 

например Foxit Reader), системата няма да работи коректно. Затова, ако заедно с Adobe 

Reader (или Adobe Acrobat) имате инсталиран и друг PDF viewer, трябва да настроите 

компютъра си така, че PDF-бланките да се отварят в Интернет браузъра чрез Adobe Reader 

(или Adobe Acrobat), а не чрез другия PDF viewer! 
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1.9 Настройки на Adobe Reader X 

1) Уверете се, че сте разрешили изпълнението на JavaScript в PDF-форми. За 

целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете JavaScript в списъка в лявата част на диалоговия прозорец  

 Уверете се, че е включена опцията Enable Acrobat JavaScript най-отгоре в 

десния панел. 

 

 
Фиг. 10 Разрешаване на ползване на Javascript в Adobe Reader X 

Забележка: Ако тази опция е изключена, при първото отваряне на справка от 

отчета, която е разработена като PDF-форма, ще се визуализира съобщение, че 

документът съдържа програмен код, без който няма да се обработи коректно 

електронната форма. В съобщението се съдържа въпрос дали желаете да позволите 

изпълнението на JavaScript. Изберете отговор „Yes”. 
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2) Ако ползвате Enhanced Security в Adobe Reader (т.е. ако е включена опцията 

„Enable Enhanced Security”), добавете адреса isbs.nsi.bg в списъка на 

Privileged Locations, в противен случай PDF-формите на справките в отчетите 

няма да работят. За целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете Security (Enhanced) в списъка в лявата част на прозореца  

 Натиснете бутона Add Host и в отворения диалогов прозорец въведете 

адреса isbs.nsi.bg 

 
Фиг. 11 Дефиниране на isbs.nsi.bg като Privileged Location 

Забележка: Дефинирането на адреса isbs.nsi.bg като Privileged Location не е 

необходимо, ако ползвате браузър MS Internet Explorer, вече сте дефинирали този 

адрес като Trusted Site и в Adobe Reader е включена опцията „Automatically trust 

sites from my Win OS security zones” (виж фигурата по-горе). 
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3) За да можете да съхранявате (копирате) въведените PDF-справки локално на 

Вашия компютър, се уверете, че е изключен т.нар. Protected Mode в Adober 

Reader X. За целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете General в списъка в лявата част на прозореца  

 Уверете се, че е изключена опцията “Enable Protected Mode at startup” 

 
Фиг. 12 Изключване на Protected Mode в Adobe Reader X 

Забележка: Опцията “Еnable Protected Mode at startup“ e нова опция в Adobe 

Reader X, която по подразбиране е включена. Ако не се изключи, ще имате 

проблеми при опит за локално съхраняване (копиране) на PDF-справките и 

данните в тях чрез натискане на бутона Save в Adobe Reader X. 

Важно: Ако вместо Adobe Reader (или Adobe Acrobat) ползвате друг PDF viewer (като 

например Foxit Reader), системата няма да работи коректно. Затова, ако заедно с Adobe 

Reader (или Adobe Acrobat) имате инсталиран и друг PDF viewer, трябва да настроите 

компютъра си така, че PDF-бланките да се отварят в Интернет браузъра чрез Adobe Reader 

(или Adobe Acrobat), а не чрез другия PDF viewer! 
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1.10 Настройки на Adobe Reader XI 

1) Уверете се, че сте разрешили изпълнението на JavaScript в PDF-форми. За 

целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете JavaScript в списъка в лявата част на диалоговия прозорец  

 Уверете се, че е включена опцията Enable Acrobat JavaScript най-отгоре в 

десния панел. 

 

 
Фиг. 13 Разрешаване на ползване на Javascript в Adobe Reader XI 

Забележка: Ако тази опция е изключена, при първото отваряне на справка от 

отчета, която е разработена като PDF-форма, ще се визуализира съобщение, че 

документът съдържа програмен код, без който няма да се обработи коректно 

електронната форма. В съобщението се съдържа въпрос дали желаете да позволите 

изпълнението на JavaScript. Изберете отговор „Yes”. 



Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
 

 

 22 

2) Ако ползвате Enhanced Security в Adobe Reader (т.е. ако е включена опцията 

„Enable Enhanced Security”), добавете адреса isbs.nsi.bg в списъка на 

Privileged Locations, в противен случай PDF-формите на справките в отчетите 

няма да работят. За целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете Security (Enhanced) в списъка в лявата част на прозореца  

 Натиснете бутона Add Host и в отворения диалогов прозорец въведете 

адреса isbs.nsi.bg 

 
Фиг. 14 Дефиниране на isbs.nsi.bg като Privileged Location 

Забележка: Дефинирането на адреса isbs.nsi.bg като Privileged Location не е 

необходимо, ако ползвате браузър MS Internet Explorer, вече сте дефинирали този 

адрес като Trusted Site и в Adobe Reader е включена опцията „Automatically trust 

sites from my Win OS security zones” (виж фигурата по-горе). 
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3) За да можете да съхранявате (копирате) въведените PDF-справки локално на 

Вашия компютър, се уверете, че е изключен т.нар. Protected Mode в Adober 

Reader X. За целта: 

 Влезте в меню Edit > Preferences...  на Adobe Reader 

 Изберете Security (Enhanced) в списъка в лявата част на прозореца  

 Уверете се, че е изключена опцията “Enable Protected Mode at startup” 

 
Фиг. 15 Изключване на Protected Mode в Adobe Reader XI 

Забележка: Опцията “Еnable Protected Mode at startup“ e нова опция в Adobe 

Reader X, която по подразбиране е включена. Ако не се изключи, ще имате 

проблеми при опит за локално съхраняване (копиране) на PDF-справките и 

данните в тях чрез натискане на бутона Save в Adobe Reader XI. 

Важно: Ако вместо Adobe Reader (или Adobe Acrobat) ползвате друг PDF viewer (като 

например Foxit Reader), системата няма да работи коректно. Затова, ако заедно с Adobe 

Reader (или Adobe Acrobat) имате инсталиран и друг PDF viewer, трябва да настроите 

компютъра си така, че PDF-бланките да се отварят в Интернет браузъра чрез Adobe Reader 

(или Adobe Acrobat), а не чрез другия PDF viewer! 
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1.11 Изискване за ползване на цифров сертификат 

Ако сте външен потребител (т.е. респондент или счетоводна къща), за да работите със 

системата, е необходимо да ползвате цифров сертификат, чрез който да се 

идентифицирате пред системата. За целта трябва да притежавате валиден цифров 

сертификат от някой от следните видове, издаден от изброените по-долу лицензирани 

доставчици на удостоверителни услуги (ДУУ) в България: 

1. ДУУ „Информационно обслужване” АД:  

 Цифров сертификат StampIT DocPro  

 Цифров сертификат StampIT Doc (за лица със свободни професии)  

2. ДУУ „Банксервиз” АД:  

 Цифров сертификат B-Trust Professional QES  

 Цифров сертификат B-Trust Personal QES (за лица със свободни професии)  

 Цифров сертификат B-Trust Professional UES  

 Цифров сертификат B-Trust Personal UES (за лица със свободни професии)  

3. ДУУ „Инфонотари” ЕАД:  

 Цифров сертификат i-Notary Company Q Sign  

 Цифров сертификат i-Notary Personal Q Sign (за лица със свободни професии)  

4. ДУУ „Спектър” АД: 

 Цифров сертификат Spektar Org Qualified Certificate 

 Цифров сертификат Spektar Personal Qualified Certificate (за лица със свободни 

професии) 

 Цифров сертификат Spektar Org Restricted Universal Certificate  

 Цифров сертификат Spektar Org Universal Certificate  

 Цифров сертификат Spektar Personal Restricted Universal Certificate (за лица 

със свободни професии)  

 Цифров сертификат Spektar Personal Universal Certificate (за лица със свободни 

професии) 

5. ДУУ „СЕП България” АД: 

 Цифров сертификат SEP Qualified Organization 

 Цифров сертификат SEP Qualified Private 

 

Внимание: В настоящия документ не са включени инструкции за инсталиране и 

конфигуриране на сертификати на работните станции на потребителите. За подробности 

относно инсталиране на хардуер, на който се съхраняват сертификатът и частният Ви 

ключ (например карточетящо устройство или  USB устройство) и интегрирането им с 

Вашия Интернет браузър се консултирайте с документацията, предоставена Ви от 

Доставчика на удостоверителни услуги, издал Вашия сертификат. 
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2. Стартиране на системата 

ИС „Бизнес статистика” може да бъде стартирана от Web-сайта на Националния 

статистически институт, където има поставена съответна препратка към модула за 

въвеждане на отчети. 

ИС „Бизнес статистика” може също така да бъде стартирана в Интернет браузър чрез 

задаване на Интернет адрес https://isbs.nsi.bg 

Внимание: Обърнете внимание, че протоколът в адреса трябва да бъде HTTPS, а не 

HTTP. Чрез използване на протокола HTTPS комуникацията между Вашата работна 

станция и централния сървър на системата в НСИ се криптира и информацията не може 

да бъде прихваната и разчетена от недоброжелателни лица при нейното преминаване през 

публичното Интернет пространство между работната станция и сървъра. 

 

При опит за достъп до системата тя изисква от Вас да укажете цифровия си сертификат, 

чрез който ще се идентифицирате пред системата. Ако сертификатът Ви се съхранява на 

смарт-карта, ще бъде изведено също и запитване за въвеждане на PIN-кода, с който е 

защитена смарт-картата. Ако указаният от Вас цифров сертификат не е от поддържаните 

от системата видове, системата няма да се стартира. За подробности относно 

поддържаните цифрови сертификати вижте точка 1.111 „Изискване за ползване на 

цифров сертификат”. Ако сертификатът Ви е валиден, ще се отвори началната страница 

на системата. 

В случай, че цифровият Ви сертификат е валиден, но след извикване на указания 

Интернет адрес не се отваря началната страница на системата, е възможно системата да е 

временно спряна за профилактика или поддръжка.  

Забележка: При първото стартиране на системата компютърът Ви автоматично изтегля 

голям обем служебни файлове, поради което в зависимост от скоростта на вашия 

Интернет е възможно да се наложи да изчакате известно време (между няколко секунди и 

1-2 минути). При първото стартиране на всяка от страниците на системата, както и при 

първото отваряне на отделните PDF-форми също може да има малко забавяне в 

зависимост от скоростта на вашия Интернет. 

Забележка: Ако имате настроена опция за автоматично изтриване на кеша на вашия 

Интернет браузър, то при всяко стартиране на системата, при стартиране на отделните 

страници за първи път, както и при отваряне на PDF-формите ще трябва да изчакате 

браузъра да изтегли в кеша си необходимите файлове. 

Ако след стартиране на системата не се ориентирате интуитивно как да ползвате 

компонентите от потребителския интерфейс (полета, бутони, списъци за избор, диалогови 

прозорци, PDF-форми и т.н.), тогава първо прочетете глава 13. „Приложение: 

Потребителски интерфейс” в края на този документ. Ако пък се ориентирате добре в 

работата с компонентите от потребителския интерфейс, тогава можете да преминете 

директно към следващата глава на настоящия документ. 

https://isbs.nsi.bg/


Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
 

 

 26 

3. Начална страница 

След стартиране на модула за въвеждане на годишни отчети на ИС „Бизнес статистика” 

се зарежда начална страница на системата: 

  

 
Фиг. 16 Изглед на началната страница 

Началната страница се състои от следните секции: 

 Секция за „Вход” на регистриран потребител; 

 Секция за „Регистрация” на нов потребител; 

 Секция „Поддръжка” с информация за адресите за контакт с НСИ по технически 

и методологически въпроси или проблеми; 

 Секция „Предназначение на системата”. 

 

Чрез бутона  системата ви препраща към страница „Работа с отчети” в 

случай, че вече сте регистриран потребител. В случай, че все още нямате регистриран 

профил или цифровият Ви сертификат не е от поддържаните от системата видове, 

системата Ви информира за това и не Ви позволява да влезете в страницата за работа с 

отчети. 

Чрез бутона  системата ви препраща към страница „Регистрация на 

потребител”, в която можете да въведете своите идентификационни данни и да се 

регистрирате като потребител на системата, ако все още не сте се регистрирали.  
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В секция  „Поддръжка” можете да използвате посочените e-mail адреси, за да изпратите 

запитване или сигнал за проблем от технически или методологически характер към 

служителите на НСИ. 

В секцията „Предназначение на системата” можете да намерите няколко полезни 

препратки: 

1) Препратки за изтегляне на файлове в PDF формат на пълните комплекти 

документи за следните изследвания, съответно: 

 Годишен отчет за 2013 година на едноличните търговци по чл. 32 от 

Закона за счетоводството; 

 Годишен отчет за 2013 година на предприятията, задължени да 

представят счетоводен баланс; 

 Годишен отчет за 2013 година на предприятията с нестопанска цел; 

 Статистически справки за 2013 година на бюджетни предприятия и 

банки; 

 Годишен отчет за 2013 година на предприятията в ликвидация или в 

несъстоятелност; 

 Годишен отчет на предприятията, ликвидирани (прекратени) през 2014 г.; 

 Декларация за неактивност през 2013 година. 

Забележка: Файловете от тези препратки могат да се използват единствено за 

попълване на хартиен носител след разпечатването им. Тези комплекти НЕ са 

електронни форми за попълване в режим off-line. Попълване на отчети в 

електронен вид може да се извършва само в режим on-line чрез настоящия 

модул за въвеждане на отчети. 

2) Препратки за изтегляне на някой от изискваните софтуерни продукти, 

необходими за коректното функциониране на системата; 

В долната част на страница можете да използвате препратката към сайта на НСИ, както 

и препратката за отваряне на настоящия документ. 
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4. Страница „Регистрация на потребител” 

Системата допуска до защитените ресурси (в частност до данни от въведени отчети) само 

регистрирани потребители, които са успешно разпознати. Разпознаването на външните 

потребители се извършва на базата на валиден електронен сертификат, а на служителите 

на НСИ – чрез системно име и парола.   

Чрез страницата „Регистрация на потребител” новите външни потребители, които все още 

нямат регистриран профил в системата, си създават профил. С помощта на тази страница 

се регистрират всички външни потребители на системата, ползващи системата през 

публичния Интернет.  

Важно: Под понятието „външен потребител” се разбира респондент или 

счетоводна къща. Ако във Вашето предприятие има повече от един служител, 

който ще работи със системата, НЕ трябва да се опитвате да регистрирате като 

отделни потребители тези служители. Всичките служители трябва да ползват 

валиден сертификат за работа със системата. 

 

Страницата се зарежда след натискането на бутона „Регистрация” от началната страница. 

При зареждането й страницата се отваря с празни полета, в които последователно от горе 

надолу трябва да се въведат всички задължителни данни: 

 
Фиг. 17 Изглед на страницата "Регистрация на потребител" 

Последователно въведете данни в следните полета: 

3) В полето „ЕИК” системата автоматично попълва ЕИК по БУЛСТАТ/ТР, 

извлечен от вашият валиден електронен сертификат. Полето не е достъпно за 

попълване. В случай, че полето не се попълни автоматично от системата е 

възможно да ползвате невалиден електронен сертификат. 

4) В полето „Наименование” въведете наименованието на предприятието/ 

счетоводната къща (или име на физическо лице) – допустими са единствено 

букви на кирилица, арабски и римски цифри, кавички и символите / . * -; 
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5) В полето „Вид потребител” изберете един от следните: 

 Респондент – потребителите от този вид имат право да въвеждат само 

собствените си отчети. Системата не позволява на потребител от вид 

„Респондент” нито да създава, нито да визуализира отчети на други 

респонденти; 

 Счетоводна къща – потребителите от този вид имат право да създават 

собствените си отчети, както и отчети на други респонденти, с които 

счетоводната къща има такава договореност. Счетоводните къщи имат 

достъп до отчетите, регистрирани в системата от самите тях и до 

собствения си отчет и нямат достъп до другите отчети в системата; 

6) В полето „E-mail за връзка” въведете валиден e-mail адрес за контакт с Вас; 

Внимание: Въведеният от вас e-mail адрес не се проверява автоматично за валидност. 

Въведеният от вас e-mail адрес при необходимост може да бъде използван за връзка с вас. 

7) В полето „Въведете показания код” трябва да въведете цифровия код, който се 

вижда на картинката под полето.  

Внимание: Стойността на картинката се променя след всеки неуспешен опит да създадете 

профила си. След отстраняване на проблема следва да запишете в полето новият код от 

картинката преди да опитате отново действие „Създай”. 

В долната част на страницата са разположени бутоните, с които може да съхраните 

данните в базата данни (БД) или да се откажете от регистрацията. 

Бутонът  изпълнява проверка на въведените данни и съхранява 

информацията в БД, ако въведените данни са коректни. В случай, че има проблеми в 

данните, системата извежда съответни съобщения. За успешната Ви регистрация трябва 

да бъдат изпълнени всички описани по-горе условия и да няма невалидни данни. При 

успешна регистрация системата визуализира информативно съобщение и автоматично Ви 

насочва към началната страница на системата, откъдето може да продължите с бутона 

„Вход”. 

Бутонът  прекратява операцията по регистриране на нов потребител и 

Ви връща в началната страница на системата. 

Внимание: В тази страница не използвайте стандартните функции на браузъра (Back, 

Forward, Refresh, ръчна промяна на URL адреса и бутона Close в горния десен ъгъл на 

прозореца), а използвайте единствено бутоните “Създай” и „Откажи”. 
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5. Страница „Профил на потребител” 

Страницата „Профил на потребител” се използва за преглед и редактиране на данните в 

личния Ви профил. 

Страницата се зарежда след натискане на бутона  „Профил”  в дясната горна част на 

заглавната ивица на страницата. Бутонът е достъпен само в защитените страници на ИС 

„Бизнес статистика”, т.е. за разпознат потребител на системата.  

 
Фиг. 18 Изглед на страница „Профил на потребител” 

В секция „Данни за потребителя” системата визуализира информацията за текущия 

потребител и осигурява възможност те да бъдат променени. За промяна са достъпни 

следните полета:  

1) В полето „Вид потребител” можете да промените своя вид, ако той не отговаря 

на действителността. За подробности виж страница „Регистрация на 

потребител”; 

2) В полето „Наименование” може да промените наименованието, с което сте 

регистрирани в системата. Тази информация се използва единствено във Вашия 

профил; 

3) В полето „E-mail за връзка” може да промените предишния посочен от Вас e-

mail адрес за контакт. 

В долната част на секцията „Данни за потребителя” са разположени бутоните, с които 

може да съхраните данните в БД или да се откажете от промените. 

Бутонът  изпълнява проверка на въведените данни и съхранява 

информацията в БД. В случай, че има проблеми в данните, системата извежда съответни 

съобщения. При успешна промяна на данните системата визуализира информативно 

съобщение. 

Бутонът  отменя всички направени от Вас промени в секцията „Данни за 

потребителя”. 

Препратката  Ви връща обратно към страницата, в която сте били преди 

отваряне на страницата „Профил”. 
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6. Страница „Работа с отчети” 

Страницата „Работа с отчети” е основната екранна форма за работа с годишните отчети. 

Страницата предоставя възможност за създаване на нов отчет, търсене на съществуващи 

отчети в БД, въвеждане и редактиране на данни в справки, преглед на констатирани 

проблеми, приключване/сторниране и анулиране/деанулиране на отчет.  

Страницата се зарежда автоматично след успешно разпознаване на потребителя от 

системата, извършено в страница „Вход”. Първоначално страницата се зарежда без да има 

визуализира данни, т.е. допълнително се изисква да извлечете търсения от вас отчет (или 

отчети). 

 

  

 
 

 

Фиг. 19 Изглед на страница "Работа с отчети" 

Работното пространство на страницата условно е разделено на две зони (ляв и десен 

панел) чрез вертикална разделителна линия (splitter). Разделителната линия може да се 

премества с помощта на мишката. С помощта на бутона  в средата на разделителната 

линия може да се скрива/показва левият панел на страницата.  

Секция „Търсене на отчети” 

Секция „Списък на отчети” 

Секция „Детайли на отчета” 

Разделител на страницата с 

бутон за преоразмеряване 



Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
 

 

 32 

Страницата се състои от следните секции: 

1) Секция „Търсене на отчети”; 

2) Секция „Списък на отчетите”; 

3) Секция „Детайли на отчета”. 

6.1 Секция „Търсене на отчети” 

В секцията „Търсене на отчети” е предоставена възможност за търсене на съществуващи 

отчети в БД. Тази секция се различава в случаите, когато потребителят, разпознат от 

системата, е вътрешен (служител на НСИ) или външен потребител (респондент или 

счетоводна къща). При вътрешните потребители секцията „Търсене на отчети” 

предоставя възможност за задаване на по-детайлен критерий за търсене. 

6.1.1 Секция „Търсене на отчети” (при външни потребители) 

 
Фиг. 20 Изглед на секция "Търсене на отчети" при външните потребители 

В падащия списък може да изберете критерий, по който искате да търсите – 

възможностите са „ЕИК”, „Име на респондент” или „Отчетен период”. В полето, 

намиращо се от дясната страна на падащия списък, може да въведете стойност, по която 

да се извърши търсене в списъка на всички отчети, до които имате достъп. В случай, че 

полето е оставено празно, при търсене ще бъдат визуализирани всички отчети, до които 

имате достъп. 

Забележка: Ако сте избрали от възможностите „ЕИК” или „Респондент”, в полето за 

търсене може да въведете и само част от търсеното значение. В този случай трябва да 

запишете символа % (маскиране на текста) пред критерия, след него или от двете страни, 

ако търсите за съвпадение съответно по завършваща част, започваща част или съдържаща 

се част.  

Пример:  

1) Търсене на отчети по ЕИК, който започва със 111: 

 Изберете от падащия списък ЕИК 

 Въведете в празното поле стойността 111% 

 Натиснете <Enter> или бутона . 

2) Търсене на отчети, чието наименование на респондента завършва с ООД 

 Изберете от падащия списък Респондент 

 Въведете в празното поле стойността %оод или %ООД (не се прави 

разлика между главни и малки букви) 

 Натиснете <Enter> или бутона . 
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3) Търсене на отчети по ЕИК, който съдържа 111: 

 Изберете от падащия списък ЕИК 

 Въведете в празното поле стойността %111% 

 Натиснете <Enter> или бутона . 

След изпълнение на търсене в таблицата под секцията за задаване на условие се зарежда 

списък на намерените отчети, отговарящи на зададеното условие. Ако няма намерени 

отчети, таблицата остава празна.  

 

6.1.2 Секция „Търсене на отчети” (при служители на НСИ) 

 
Фиг. 21 Изглед на секция „Търсене на отчети” при вътрешните потребители 

 
Фиг. 22 Изглед на секция „Търсене на отчети” при вътрешните потребители 

(разширено търсене) 
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В тази секция има два режима на задаване на условие за търсене – базово и разширено 

търсене. Режимът на търсене може да се смени при натискане на бутона в горния десен 

ъгъл на секцията. В режим на базово търсене има само следните полета за търсене: „ID на 

отчет”, „Състояние”, „С предупреждения”, „ЕИК”, „Респондент” и „Изследване”. 

Можете да зададете условие за търсене в няколко от полетата като опцията 

„Съответствие” указва дали полетата ще се комбинират в критерий чрез логическото 

„И” или чрез логическото „ИЛИ”. Тук полетата „ЕИК”, „Респондент” и „Изследване” 

разрешават търсене по част от значението като при търсене по започваща част няма 

нужда се маскира въведения в полето текст с символа % в неговия край. Но ако искате да 

извършите търсене по завършваща или съдържаща се част, трябвате въведете % преди 

текста. Режимът на разширено търсене разрешава добавянето на още полета за търсене и 

прилагане на специфични оператори за филтриране към тях (Започва с, Равно на, 

Съдържа). 

Пример:  

1) Търсене на отчети с ЕИК, който започва със 111 и име на респондент, което 

започва с ЕТ: 

 Въведете в полето ЕИК стойността 111 

 Въведете в полето Респондент стойността ЕТ (тук се прави разлика 

между главни и малки букви!) 

 Натиснете <Enter> или бутона . 

2) Търсене на отчети с ЕИК, който съдържа 111 и име на респондент, което 

завършва на ООД: 

 Въведете в полето ЕИК стойността %111 

 Въведете в полето Респондент стойността %ООД 

 Натиснете <Enter> или бутона . 

3) Търсене на всички отчети, които са в състояние Нов/Непроверен или състояние 

Проблемен: 

 Натиснете бутона  

 Изберете за съответствие  

 Натиснете бутона  и изберете полето Състояние. По този 

начин се появява второ поле Състояние в секцията. 

 Срещу първото поле Състояние изберете оператор Равно на и стойност  

Нов/Непроверен, а срещу второто изберете оператор  Равно на и стойност 

Проблемен. 

 Натиснете <Enter> или бутона . 

След изпълнение на търсене в таблицата под секцията за задаване на условие се зарежда 

списък на намерените отчети, отговарящи на зададеното условие. Ако няма намерени 

отчети, таблицата остава празна. 
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6.2 Секция „Списък на отчети” 

В тази секция под формата на таблица се визуализират всички отчети, отговарящи на 

търсеното условие, до които имате разрешен достъп. Системата контролира достъпа до 

отчетите по следните правила: 

 Респондентите имат право на достъп само до собствените си отчети. Ако отчетът 

на респондента е въведен от друг потребител на системата (от счетоводна къща 

или от служител на НСИ), достъпът на респондента до отчета е само за четене; 

 Счетоводните къщи имат право на достъп до собствения си отчет и до всички 

отчети, регистрирани от самите тях. Също както при респондентите, ако 

собственият отчет на счетоводната къща е въведен не от нея, а от друг 

потребител на система (например от служител на НСИ), достъпът до отчета е 

само за четене; 

 Служителите от ТСБ имат достъп до отчетите на предприятията с регистрация 

или местонамиране на дейността в обслужвания от това ТСБ регион и до 

отчетите, въведени в това ТСБ; 

 Служителите от НСИ/ЦУ имат достъп до всички отчети в системата.  

 

Таблицата е предназначена само за четене и преглед на отделните редове (отчети). При 

позициониране в конкретен ред от таблицата детайлите на избрания ред (отчет) се 

визуализират в десния панел на страницата. 

В първата колона на таблицата – „Състояние” – е показано текущото състояние на 

съответния отчет. Използвани са различни цветове-индикатори на състоянието както 

следва:  

  Нов / Непроверен; 

  Проблемен; 

  Успешно обработен; 

  Успешно обработен (с предупреждения); 

  Анулиран. 

В останалите колони на таблицата се визуализират съответно ЕИК, името на респондента 

и вида на изследването, за което се отнася отчета. 

  

Таблицата предоставя възможност за сортиране на отчетите по избрана от потребителя 

колона. При позициониране на курсора на мишката върху заглавието на някоя колона се 

визуализират две стрелки – при натискането на някоя от стрелките отчетите се сортират 

във възходящ или низходящ ред в зависимост от избраната стрелка.  
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Чрез бутона  можете да създадете нов отчет. При натискането на бутона се 

отваря диалогов прозорец, където трябва да изберете вид на изследването, за което се 

отнася отчета и да се попълнят данни за заглавната част на отчета – Респондент (ЕИК и 

наименование на предприятието), Ръководител, Съставител, Лице за контакт, Телефон и 

Забележки.  

 
Фиг. 23 Изглед на диалогов прозорец за въвеждане на нов отчет 

 В полето „Респондент” се въвежда наименованието на предприятието – 

допустими са само символи на кирилица, арабски и римски цифри, единична 

кавичка и символите / , -; 

 В полетата „Ръководител”, „Съставител” и „Лице за контакт” се въвеждат 

имената на съответните Ваши отговорни служители – трябва да се въведат от две 

до четири имена, изписани на кирилица; 

 В полето „Тел. за контакт” се въвежда валиден телефон за връзка (Пример: +359 

88 7864334; 088 4538999). 

 

За успешното съхраняване на отчета е необходимо да бъдат попълнени всички 

задължителни полета (маркирани със знака *).  При натискане на бутона  данните за 

новия отчет се съхраняват в базата данни и се визуализират в секцията „Детайли на 

отчета”. При наличие на грешки във въведените данни системата ще изведе съответно 

съобщение с описание на проблемите. След отстраняването им може да ги съхраните 

отново или чрез бутона  да се откажете от създаване на отчета. 

Чрез бутона  можете да промените данните от заглавната част на 

конкретен отчет. При натискането на бутона се отваря същия диалогов прозорец както 

при създаването на нов отчет. Полето „Изследване” може да се променя само в случай, че 

в отчета все още няма въведени справки. Полето „ЕИК” може да се променя само, ако 

потребителят не е от вид „Респондент”. При натискане на бутона  направените 

промени се съхраняват в базата данни. 
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6.3 Секция „Детайли на отчета” 

В тази секция се визуализират заглавните данни за конкретно избран отчет – Респондент 

(ЕИК и наименование на предприятието), Забележки и списъка със справки от отчета. 

При създаване на нов отчет системата автоматично генерира уникален вътрешно системен 

идентификатор на отчета (ID) и според вида на изследването автоматично попълва 

информацията за отчетния период. Ако потребителят, е от вид „Респондент”, системата 

визуализира номера на идентификатора, едва след като отчетът премине в състояние 

„Успешно обработен”. Също така при създаване на нов отчет от респондент, системата 

автоматично попълва и полето за ЕИК и го забранява за промяна, тъй като тези 

потребители имат право да създават само собствените си отчети.  

В горната част на секцията „Детайли на отчета” е разположена лента с бутони, чрез които 

се извършват действията по приключване/сторниране и анулиране/деанулиране на отчета. 

Отделните бутони в тази лента се визуализират в зависимост от текущото състояние на 

отчета. 

6.3.1 Лента с командни бутони 

1) Бутонът  се използва за опресняване върху страницата данните за текущия 

отчет; 

Забележка: Използвайте този бутон, за да опресните информацията за даден 

отчет, в случай че сте съхранили или валидирали конкретна справка, за която се 

използва PDF-форма. PDF-формите се отварят в отделен прозорец на браузъра и 

при тяхното съхраняване или валидиране основният прозорец за работа с отчетите 

не получава информация за извършеното действие. При съхраняване и валидиране 

на справка системата извежда подходящи съобщения за успешно или неуспешно 

действие в самата PDF-форма без да променя визуално статуса на справката в 

страницата на отчета, както и не презарежда автоматично списъка на 

констатираните проблеми при валидирането на справката, ако има такива. 

N.B. Този бутон не е аналогичен на стандартната функционалност на браузъра за 

опресняване на страницата (F5-Refresh). Натискане на клавиша <F5>, както и 

натискане на бутона Refresh на браузъра, трябва да НЕ се извършва. 

2) Бутонът  изпълнява действие „Приключване” (Обработване) на 

целия отчет. При тази обработка системата извършва „Валидиране” на всяка 

попълнена в отчета справка поотделно, след което извършва предвидения 

логически контрол на ниво цял отчет (логическите проверки, касаещи данни 

от повече от една справка едновременно, се изпълняват само при 

приключване на отчета, а не при валидиране на отделните справки). 

Този бутон е достъпен само за отчети в състояние „Нов/Непроверен” и „Проблемен”. 

 

При изпълнение на операцията „Приключване” могат да възникнат следните 

ситуации: 

 При обработката на отчета са констатирани проблеми от тип 

„задължителен контрол” (фатална грешка) – в този случай системата 

маркира отчета като „Проблемен”. Констатираните проблеми се 
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преглеждат в тематичната страница „Проблеми” в долната част на секция 

„Детайли на отчета”; 

 При обработката на отчета са констатирани само проблеми от тип 

„препоръчителен контрол” (предупреждения) – в този случай системата  

визуализира съобщение за потвърждение от потребителя, дали отчета да 

бъде приет за успешно обработен. Имате възможност да потвърдите 

обработката или да не я приемете, защото възнамерявате да отстраните 

констатираните предупреждения; 

 При обработката на отчета не са констатирани проблеми – в този случай 

системата маркира отчета като успешно обработен. 

3) Бутонът  изпълнява действие „Сторниране на приключване на 

отчет”, т.е. връщане на отчета от статус „Успешно обработен” обратно в статус 

„Нов / Непроверен”, в който отново може да бъде коригиран и обработван. 

Забележка: Сторниране се налага в случай, че е необходима корекция във вече успешно 

приключен отчет. Ако отчетът е в състояние „Успешно обработен” или „Анулиран”, 

системата забранява редактирането му. Поради това, ако се налага да бъдат променени 

данните в успешно обработен отчет, първо трябва да се сторнира неговото приключване 

(при което отчетът се връща обратно в състояние „Нов/непроверен”), да се нанесат 

промените и да бъде приключен отново. 

Този бутон е достъпен само за отчети в състояние „Успешно обработен”. 

4) Бутонът  изпълнява действие „Анулиране” на „Нов/Непроверен” 

или „Проблемен” отчет. След извършване на действието отчетът променя 

състоянието си в „Анулиран”. При това състояние системата не позволява да се 

променят данните в отчета и те са достъпни само за четене и разпечатване. 

Забележка: Анулиране се извършва в случай на неправилно попълнен отчет – примерно 

неправилно сте попълнили ЕИК при създаване на нов отчет или има много допуснати 

грешки в справките. Системата не позволява промяна на ЕИК в заглавната част на отчет, 

както и изтриване на отчет и при подобен случай трябва да анулирате отчета, ако той не 

трябва да се използва. 

Бутонът е достъпен  само за отчети в състояние „Нов/Непроверен” и „Проблемен”. 

5) Бутонът  изпълнява действие „Деанулиране” на вече анулиран 

отчет. След извършване на операцията отчетът преминава в състояние „Нов / 

Непроверен” и отново може да бъде редактиран и обработван. 

Бутонът е достъпен само за отчети в състояние „Анулиран”. 
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6.3.2 Панел „Детайли на отчета” 

Този панел има различен изглед за вътрешни и външни потребители. В него се 

визуализират „само за четене” заглавните данни за конкретно избран отчет. 

 
Фиг. 24 Изглед на панела „Детайли на отчет” за вътрешни потребители (служители на НСИ) 

 

 
Фиг. 25 Изглед на панела „Детайли на отчет” за външни потребители 

За промяна на заглавните данни в отчета („Изследване”, „ЕИК”, „Респондент” или 

„Забележки”) трябва да натиснете бутона  в секцията „Списък на 

отчети”. Полето „Изследване” може да се променя само в случай, че все още няма 

въведени справки в отчета. Полето „ЕИК” може да се променя само от служители на НСИ 

или счетоводни къщи, тъй като потребителите от вид „Респондент” могат да въвеждат и 

редактират само собствените си отчети.  

При външните потребители номерът на уникално генерирания системен идентификатор 

(Входящ номер) се визуализира, след като отчетът премине в състояние „Успешно 

обработен”.  

Долната част от секцията „Детайли на отчета” е разделена на три тематични страници, 

както следва: 
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6.3.3 Тематична страница Справки 

 
Фиг. 26 Изглед на тематична страница "Справки" 

В тематичната страница „Справки” системата визуализира списък на всички справки от 

годишния отчет, които са дефинирани за съответният вид изследване. Списъкът е 

различен според вида на изследването. 

1) В първата колона на таблицата се визуализира пореден номер на справката; 

2) В следващата колона се визуализира пълното наименование на справката, което 

представлява препратка за отваряне на справката. Всички справки с изключение 

на „Справка за предприятието”, „Справка за група предприятия“, „Справка 

ПРОДЕНЕРДЖИ“ и „Справка ПРОДКОМ” се отварят като PDF-форми; 

3) В колоната „Състояние” се визуализира текущото състояние на съответната 

справка: 

Справката може да бъде в едно от следните три състояния –  „Непроверена”, „Валидна”, 

„Проблемна”, а също може и полето да е празно. Когато полето е празно, това е 

индикатор, че справката не е въвеждана до този момент (т.е. в базата данни липсва 

съхранена такава справка). В състояние „Непроверена” са тези справки, в които са 

съхранени данни, които все още не са валидирани. В състояние „Валидна” са справките, 

които са съхранени и са валидирани успешно, а в състояние „Проблемна” са справките, 

при чиято валидация са открити проблеми от тип „фатална грешка”. 

4) В колоната „Код на бланката” се визуализира използваният от системата код за 

идентификация на всяка бланка; 

Забележка: Кодът на справката се използва в текста на констатираните проблеми при 

приключване на отчет; 

5) В последната колона на таблицата има бутон , чрез който системата 

позволява в случай на нужда да бъде изтрита съответната справка от отчета. 
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В отчета се попълват само тези справки, за които имате задължение да се отчитате. В 

логическите проверки са заложени контроли, които изискват да имате попълнена дадена 

справка. Не е необходимо да отваряте и да съхранявате празни справки, които не трябва 

да отчитате. В случай, че сте съхранили празна справка, системата ще регистрира 

проблем, с който не може да приключите отчета. За да отстраните проблема, или 

попълнете справката, или я изтрийте с помощта на бутона в списъка със справките. 

Бутонът е достъпен докато отчетът е разрешен за редактиране. 

 

Системата предоставя функционалност за въвеждане на детайлни справки за някои от 

отчетите. За подробности относно създаването им виж точка „6.3.6 Създаване на детайлна 

справка” от настоящия документ. 

 

При отваряне на справка от списъка (чрез mouse click върху наименованието на 

справката), за която се използва PDF-форма, отваряната справка се зарежда в отделен 

прозорец на браузъра, където автоматично се активира Adobe Reader plug-in. Системата 

автоматично попълва данните в полетата „Отчетна единица”, „Гр. (с.)”, „Община”, „ЕИК 

по БУЛСТАТ / ТР”, които са полета само за четене. При въвеждането на детайлни 

справки аналогично се попълват и полетата „Обл.”, „Общ.”, „Дейност” и „Звено”. 

Полетата в края на бланката : „Ръководител”, „Съставител”, „Лице за контакт”, „Дата” и 

„Телефон”, също се попълват автоматично от системата, но данните в тях (с изключение 

на „Ръководител”) могат да се променят, ако са различни за конкретната справка. При 

първо отваряне на справка данните се извличат от заглавните детайли на отчета и се 

попълват в тези полета.  

В PDF-формите се попълват данните в полетата, разрешени за попълване. Част от 

полетата са дефинирани като сумарни полета или се получават в резултат на изчисления. 

Тези полета не са достъпни за промяна от потребителя. Техните стойности автоматично 

се изчисляват при попълване на полетата, участващи в изчислението им.  

Бутонът  в края на PDF-формата се използва, за да се съхранят 

направените промени в справката в базата данни.  

Бутонът  в края на PDF-формата изпълнява последователно действие 

„Съхраняване” и действие „Валидиране” на справката, при което системата извършва 

предвидения логически контрол на данните в справката. След като се валидира една 

справка системата извежда информативно съобщение, описващо констатираните 

проблеми и техния вид, ако има такива. Ако не са констатирани проблеми, системата 

извежда информативно съобщение за успешно „Валидиране”. След съхраняване или 

валидиране на PDF-форма, за да видите в основния прозорец на приложението актуалния 

(новия) статус на справката, трябва да използвате бутона  в горната част на основния 

прозорец, чрез който се извършва опресняване на данните за текущия отчет в страницата 

на браузъра. 
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Важно: Системата се изключва автоматично, ако повече от 30 минути не изпратите заявка 

към сървъра. В частност, ако отворите PDF-справка и работите в нея повече от 30 минути 

без да съхраните (или валидирате) данните, въведени на екрана, системата ще се изключи. 

В този случай ще загубите данните, въведени на екрана и ще трябва да ги въведете 

отново. За да избегнете подобна ситуация, ако сте въвели или коригирали някакви данни, 

ги съхранете своевременно без да чакате прекалено дълго време. По-късно винаги можете 

да коригирате съхранените данни, ако се наложи.  

 

Важно: Справките могат да бъдат разглеждани on-line или разпечатвани дори и след края 

на срока за подаване на съответните отчети.  

 

Важно: Копия на попълнените справки от отчета могат да бъдат съхранявани като 

файлове локално на Вашия компютър. Тази функционалност е налична за отчетите от 

2012 година нататък. Локално съхранените копия на справките не могат да бъдат 

редактирани и/или подавани по-късно към системата (т.е. това не е функционалност за 

работа в режим off-line, а е само възможност за поддържане на архив на подадените 

отчети локално на Вашия компютър). За повече подробности виж глава 13.3. 

„Съхраняване на съдържанието на отчети локално на компютъра”. 



Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
 

 

 43 

6.3.4 Тематична страница „Проблеми” 

В тематичната страница „Проблеми” системата визуализира в йерархичен вид всички 

констатирани проблеми от задължителен характер (фатални грешки) и/или от 

препоръчителен характер (предупреждения) в рамките на целия отчет. 

 
Фиг. 27 Изглед на тематична страница "Проблеми" 

Констатираните проблеми са групирани и подредени по справки, а тези, които не касаят 

конкретна справка или касаят кръстосана проверка между различни справки, са 

обособени в отделна група („Проблеми на ниво Отчет”). Системата позволява да 

отваряте или затваряте групите в йерархията чрез бутона View или чрез контекстно меню. 

Системата позволява списъкът с проблемите да се експортира в MS Excel чрез бутона . 

При изпълнението на това действие се експортират само тези проблеми, които се 

визуализират на екрана. (В частност, ако сте обработили някоя справка в PDF-формат, 

първо опреснете данните за отчета чрез бутона  в горната част на екрана, след което 

експортирайте проблемите в MS Excel). 

 

Забележка: Проблемите, свързани с кръстосани засичания на свързани данни от различни 

справки, се визуализират в групата „Проблеми на ниво Отчет” (виж фигурата по-горе). 

Кръстосаните проверки между данните на различни справки не се извършват при 

валидиране на отделна справка, а се извършват само при опит за приключване на целия 

отчет. Поради тази причина при валидиране на отделна справка списъкът на проблемите 

от групата „Проблеми на ниво отчет” не се изчиства автоматично. За да го актуализирате 

или изчистите (след като сте коригирали проблемните справки), трябва отново да 

направите опит за приключване на отчета чрез натискане на бутона . 

Не се притеснявайте, че може погрешно да приключите отчета преди да сте завършили 

напълно неговото въвеждане, тъй като винаги може да сторнирате приключването чрез 

бутона . 
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6.3.5 Тематична страница „Служебна информация” 

В тематичната страница „Служебна информация” системата визуализира за четене 

следните служебни данни за отчета:  

 Имена и телефон на служителите, отговорни за попълнените данни в отчета;  

 От кой потребител е регистриран първоначално отчета; 

 Точно време на регистриране на отчета; 

 От кой потребител последно е направена промяна в данните на отчета; 

 Точно време на последна промяна; 

 Кой потребител е обработил последно отчета; 

 Точно време на последната обработка на отчета. 
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6.3.6 Създаване на детайлна справка за поделение или различна 

икономическа дейност 

За някои справки в дадени изследвания (например за справка ТРУД) системата 

предоставя възможност за регистриране на детайлни справки, съдържащи данни само за  

определена област, община и икономическа дейност. В тематичната страница „Справки”, 

въведените детайлни справки се визуализират в списъка под съответната обобщена 

справка от годишния отчет. 

 
Фиг. 28 Изглед на списъка с въведени детайлни справки за ТРУД 

Въвеждането на нова детайлна справка се извършва като под наименованието на 

съответната обобщена справка се натисне препратката: 

  
При това се отваря диалогов прозорец, където трябва да се укажат „Област”, „Община”, 

„Икономическа дейност” и „Номер на поделение”.  

 

 
Фиг. 29 Изглед на диалогов прозорец за въвеждане на нова детайлна справка 

Полетата в диалоговия прозорец, които са маркирани със знака *, са задължителни за 

въвеждане. При натискане на бутона  се отваря съответната PDF-форма, където 

потребителят попълва данни  за съответното поделение или икономическа дейност. Едва 

при натисне на бутона  в края на PDF-формата въведената детайлна 

справка се съхранява в базата данни на системата. За да видите справката в списъка с 

отчети трябва да натиснете бутона  за опресняване на данните. 

 

Забележка: При въвеждане на детайлна справка на нефинансово предприятие системата 

не изисква указване на икономическа дейност, тъй като в този случай по подразбиране се 

използва основната икономическа дейност, изчислена в „Справка за предприятието”. 

Забележка: При попълване на справка ТРУД институциите (вкл.общините), които 

подават отчети по изследване „<Година>-БПБ” и които имат повече от една дейност или 

извършват дейност в повече от една община, могат да подадат само детайлни справки 

(т.е. не е задължително да подадат обобщена справка за цялата институция). 
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7. Страница „Справка на предприятието” 

Страницата „Справка на предприятието” предоставя възможност за въвеждане и 

редактиране на данните от справката за предприятието в годишния отчет.  

Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 

избор на препратката Справка за предприятието през 2013 година от списъка със 

справките в отчета. 

Страницата „Справка на предприятието” се състои от няколко раздела, както следва: 

7.1 Лента с командни бутони 

В горната част на страницата „Справка за предприятието” е разположена лента с бутони, 

извършващи необходимите операции по съхраняване на данните, отмяна на направените 

промени и валидиране на справката. 

1) Бутонът   се използва за връщане към страница „Работа с 

отчети”: 

При натискане на този бутон системата проверява за извършени промени и ако има 

направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 

промени. Системата извежда съответно предупредително съобщение за извършени 

промени, които не са потвърдени или отменени. В този случай преди да напуснете 

страницата, трябва да вземете решение дали да съхраните или отмените промените, след 

което отново можете да натиснете бутона . 

2) Бутонът  отваря отваря нов прозорец с PDF-бланка, попълнена с 

данните от „Справка за предприятието“: 

PDF-бланката се използва само за разпечатване в необходимия формат или съхраняване на 

копие от справката на локалния компютър (като съхраняване може да се извършва само за 

изследванията от ГОД-2012 включително нататък). 

3) Бутонът  съхранява направените от Вас промени, ако има такива; 

4) Бутонът  отменя направените от Вас промени, ако има такива: 

Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 

не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 

въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

5) Бутонът  изпълнява действие „Валидиране” на справката на 

предприятието, при което системата извършва предвидения логически контрол 

за справката; 

При наличие на проблеми системата ще изведе съобщение с кратко описание на 

констатираните при валидирането проблеми. Възможно е да бъдат констатирани 

проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 

(предупреждения). При наличие на фатални грешки системата маркира справката като 

„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 

маркира справката като „Валидна”. 
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7.2  Раздел „Име и адрес на предприятието” 

 
Фиг. 30 Изглед на раздел „Име и адрес на предприятието” 

В този раздел се попълват данни за адреса на предприятието и допълнителна информация 

като телефони, Интернет страница и електронна поща. Въвеждането на информацията се 

извършва последователно отляво на дясно и отгоре надолу. За успешното въвеждане на 

този раздел е необходимо да бъдат въведени всички задължителни полета и поне един 

телефонен номер или мобилен телефон.  

Попълването на полетата „Населено място” и „Улица” се извършва чрез помощен списък, 

който се визуализира след натискане на бутона . Тези помощни списъци се филтрират 

в зависимост от избраната административна област, община и населено място. 

Забележка: Полето „Код по ЕКАТТЕ” се попълва автоматично от системата след 

избиране на населено място от помощния списък. 
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7.3 Раздел „Място на извършване на дейността” 

 
Фиг. 31 Изглед на раздел „Място на извършване на дейността” 

В този раздел се попълва населеното място, в което предприятието извършва 

преобладаващата си дейност (това е дейността, изчислена като „Основна дейност по 

КИД-2008” при валидирането на справката – виж в раздел „Други данни”), както и на 

колко места предприятието извършва дейност. Ако броят места, на които предприятието 

извършва дейност, е по-голям от 1, трябва да бъдат въведени толкова на брой записа в 

раздела „Местни единици”. 

Попълването на полето „Населено място” се извършва аналогично на подобното поле в 

раздел „Име и адрес на предприятието”. 

Забележка: Полето „Код по ЕКАТТЕ”, „Код на поречие” и „Поречие” се попълват 

автоматично от системата след избиране на населено място от помощния списък. 

7.4 Раздел  „Собственост” 

 
Фиг. 32 Изглед на раздел „Собственост” 

В този раздел се въвеждат в % относителните дялове от капитала за отделните видове  

собственост, които предприятието има. Допустими са числа с десетична запетая до 2 

знака в интервала 0,01 до 100,0. Сборът на всички дялове трябва задължително да е равен 

на 100%. Не е необходимо да се попълват нули за видовете собственост, които 

предприятие няма.  

Забележка: Разделът не се визуализира и не се попълва в Отчета на еднолични търговци 

по чл.32 от Закона на счетоводството. 

Забележка: При въвеждането на дробни числа трябва да се използва символът запетая (,), 

а не точка (.). 
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7.5 Раздел „Икономическа дейност” 

 
Фиг. 33 Изглед на раздел „Икономическа дейност” 

В този раздел се въвеждат икономическите дейности на предприятието, за които то има 

ненулев дял на приходите от продажби. За извършване на действия в таблицата се 

използва лентата с бутони в горната й част: 

Създаването на нов запис в таблицата с икономически дейности се извършва чрез бутона 

. Новият запис след натискане на бутона се създава най-отпред в таблицата.  

Изтриването на вече въведен запис в таблицата с икономически дейности извършвани от 

предприятието се осъществява чрез бутона . При натискането на бутона 

 системата изисква допълнително потвърждение. 

Данните, които се въвеждат в този раздел, са както следва: 

 При създаване на нов запис системата автоматично генерира пореден номер в 

полето „№”, който при желание от страна на потребителя може да бъде 

променен преди съхраняването на записа в БД. След съхраняване на записа 

полето се забранява за промяна. 

Забележка: Стойността в полето трябва да бъде цяло число, уникално в рамките на 

таблицата с дейностите за конкретното предприятие. 

 Полето „Дейности, които е извършвало предприятието” се попълва автоматично 

от системата след  попълване на полето „Код по КИД-2008 (виж по-долу).  

 В полето „Относителен дял на тази дейност” ръчно се въвежда процентният дял 

на дейността (цяло число в %); 

Сборът на относителните дялове на всички въведени икономически дейности трябва да е 

не по-малък от 75% и не трябва да надвишава 100%. Проверката на този сбор се извършва 

от системата при валидиране на справката. 

 В полето „Код по КИД-2008” се въвежда код от класификатора на 

икономическите дейности КИД-2008. Кодът може да се въведе ръчно в 

необходимия формат (например 46.38) или чрез използване на помощен списък, 

визуализиран след натискане на бутона  (виж забележките по-долу). След 

попълване на полето системата търси съответстващия код от класификацията на 

икономическите дейности по НКИД-2003. Възможни са следните случаи: 

 На избраната икономическа дейност по КИД-2008 съответства точно една 

дейност по НКИД-2003 – в този случай системата автоматично попълва 

полето „Код по НКИД-2003”; 
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 На избраната икономическа дейност по КИД-2008 съответства повече от 

една дейност по НКИД-2003 – в този случай собственоръчно трябва да 

изберете елемент от помощния списък на класификатора по НКИД-2003; 

 Полето „Код по НКИД-2003” се попълва автоматично от системата или чрез 

използване на помощния списък. 

 

Забележка: В помощния списък за избор на икономическа дейност можете да търсите по 

част от името на дейността. Така, например, ако искате да извлечете списъка на всички 

дейности, в името на които се съдържа низът „зелен”, трябва да напишете в полето за 

търсене „%зелен” (без кавичките) и да натиснете кръглия бутон вдясно от полето: 

 
Фиг. 34 Търсене в помощен списък по част от наименование 

Ако в полето за търсене не напишете символа % в началото на низа, помощният списък 

ще извлече само тези дейности, чиито имена започват със „зелен”. 

 

Забележка: Помощните списъци на класификациите на икономическите дейности 

взаимно се филтрират. При попълнен код по КИД-2008 списъкът от дейностите по 

НКИД-2003 се ограничава до съответстващите елементи на попълнения код по КИД-2008. 

При попълнен код по НКИД-2003 списъкът от дейностите по КИД-2008 се ограничава до 

съответстващите елементи на попълнения код по НКИД-2003. Ако искате да попълните 

друг код, който не се визуализира в списъка, трябва да изтриете ръчно стойността на 

полето „Код по КИД-2008”, след което списъкът ще покаже пълната класификация. 

Забележка: Кодът по КИД-2008 не трябва да се дублира в таблицата с икономическите 

дейности на конкретното предприятие, т.е. не може в таблицата да има 2 или повече реда 

с един и същ код на дейност по КИД-2008.  

Забележка: Максималният брой записи в таблицата с икономически дейности за 

еднолични търговци по чл.32 от Закона на счетоводството е 6, а за предприятия 

задължени да предоставят счетоводен баланс, е 10. Ако предприятието има повече 

дейности, трябва да бъдат въведени първите 6 (респективно 10), които са с най-голям дял. 
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7.6 Раздел „Социално предприятие“ 

 
Фиг. 35 Изглед на раздел "Социално предприятие" 

Този раздел фигурира само в някои изследвания. В него трябва да укажете дали Вашето 

предприятие реализира дейности със социална насоченост (виж инструкциите в долната 

част на раздела в потребителското приложение).  

7.7 Раздел „Местни единици” 

 
Фиг. 36 Изглед на раздел "Местни единици" 

В този раздел се въвеждат данни за всички активни местни единици на предприятието. 

Разделът се визуализира единствено за предприятия, извършващи дейност на повече от 1 

място, т.е. ако стойността в полето „На колко места Вашето предприятие извършва 

дейност” в раздел „Място на извършване на дейността” е по-голяма от 1 (полето се 

визуализира и попълва само в определени изследвания). 

Въвеждането на данни за местна единица се извършва чрез бутона  от лентата с 

бутони над таблицата на местните единици. След натискането на бутона се отваря нов 

прозорец със заредена страница „Справка за местните единици”, в която се въвеждат 

необходимите данни (за подробности виж страница „Справка за местните единици”). В 

таблицата на местните единици се визуализират избрани полета от данните на 

въведените местни единици. 

При необходимост от корекции на въведените данни за определена местна единица 

използвайте бутона , който визуализира в отделен прозорец данните на 

избраната (селектираната) в таблицата местна единица. 

Бутонът  се използва за изтриване на вече въведена местна единица.  
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Бутонът  отваря нов прозорец с PDF-бланка, попълнена с данните на 

избраната в таблицата местна единица. PDF-бланката се използва само за  разпечатване в 

необходимия формат или съхраняване на копие от справката на локалния компютър 

(като съхраняване може да се извършва само за изследванията от ГОД-2012 вкл. нататък). 

7.8 Раздел „Други данни” 

 
Фиг. 37 Изглед на раздел „Други данни” 

Данните в този раздел се изчисляват и визуализират автоматично от системата след 

валидиране на „Справка на предприятието”, което се извършва чрез бутона . 

Данните в раздела се изчисляват по определени алгоритми, заложени в системата. 

Данните в този раздел са само за четене и не могат да бъдат променяни ръчно. 
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8. Страница „Справка за местна единица” 

Страницата „Справка за местна единица” предоставя възможност за въвеждане и 

редактиране на данните за конкретна местна единица. 

Страницата се зарежда чрез натискане на бутона  или  в раздел 

„Местни единици” на страницата „Справка на предприятието” на конкретно избран отчет. 

8.1 Лента с командни бутони 

В горната част на страницата „Справка за местни единици” е разположена лента с бутони, 

извършващи необходимите операции по съхраняване на данните и отмяна на направените 

промени: 

1) Бутонът  съхранява направените от Вас промени, ако има такива, 

след което визуализира отново страницата „Справка на предприятието”; 

При натискането на бутона  системата проверява дали са попълнени 

задължителните полета в страницата и дали е спазен необходимия формат за въвеждане. В 

случай, че това не е изпълнено, системата визуализира съответно съобщение за грешка, 

направените промени не се съхраняват в базата данни и се възпрепятства връщането в 

страницата „Справка на предприятието”. 

2) Бутонът  отменя направените от Вас промени, ако има такива 

след което визуализира отново страницата „Справка на предприятието”; 

3) Бутонът  визуализира методологическите указания за попълване на 

страницата. 

4) Бутонът  отваря нов прозорец с PDF-бланка, попълнена с данните на 

избраната (селектираната) в таблицата местна единица. PDF-бланката се 

използва единствено за разпечатване в необходимия формат или съхраняване на 

копие от справката на локалния компютър (като съхраняване може да се 

извършва само за изследванията от ГОД-2012 включително нататък). 
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Фиг. 38 Примерен изглед на „Справка за местна единица“ 
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8.2 Раздел „Идентификация на местната единица“ 

В най-горната част на справката трябва да се укаже дали местната единица е нова или е 

съществувала и през предходната година. 

Ако бъде указано, че местната единица е съществуваща, в екрана ще се появи падащ 

списък с наличните местни единици на това предприятие в Регистъра на статистическите 

единици на НСИ. В този списък трябва да се укаже коя съществуваща местна единица от 

регистъра е тази. В полето под падащия списък ще се визуализира адресът на избраната 

местна единица от РСЕ (такъв, какъвто е регистриран в РСЕ). Името и адреса на местната 

единица също така ще се попълнят автоматично по-долу, където можете да ги 

редактирате, ако старите данни вече не са актуални. 

 

 
Фиг. 39 Избор на съществуваща местна единица 

Ако пък бъде указано, че местната единица е нова (т.е. не е съществувала през 

предходния период и за нея тепърва се подават данни), името и мястото на извършване на 

дейността трябва да се попълнят ръчно. 

8.3 Раздел „Място на извършване на дейността” 

В този раздел се попълват данни за мястото на извършване на дейността, както и 

допълнителна информация като телефони, Интернет страница и електронна поща. 

Въвеждането на информацията се извършва последователно отляво на дясно и отгоре 

надолу. За успешното въвеждане на този раздел е необходимо да бъдат въведени всички 

задължителни полета и поне един телефонен номер или мобилен телефон.  

Попълването на полетата „Населено място” и „Улица” се извършва чрез помощен списък, 

който се визуализира след натискане на бутона . Тези помощни списъци се филтрират 

в зависимост от избраната административна област, община и населено място. 

Забележка: Полетата „Код по ЕКАТТЕ”, „Код на поречие” и „Поречие” се попълват 

автоматично от системата след избиране на населено място от помощния списък. 



Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
 

 

 56 

8.4 Раздел „Икономическа дейност“ 

 
Фиг. 40 Изглед на раздел „Икономическа дейност ” 

В този раздел се указва икономическа дейност на местната единица: 

 В полето „Код (КИД-2008)” се въвежда код от класификатора на 

икономическите дейности КИД-2008. Кодът се въвежда ръчно в необходимия 

формат (например 46.38) или чрез използване на помощен списък, визуализиран 

след натискане на бутона . След попълване на полето система търси 

съответстващия код от класификатора на икономическите дейности по НКИД-

2003. Възможни са следните случаи: 

 На избраната икономическа дейност по КИД-2008 съответства точно една 

дейност по НКИД-2003 – в този случай системата автоматично попълва 

полето „Код по НКИД-2003”; 

 На избраната икономическа дейност по КИД-2008 съответства повече от 

една дейност по НКИД-2003 – в този случай потребителят 

собственоръчно трябва да избере елемент от помощния списък на 

класификатора по НКИД-2003. 

 Полето „Код по НКИД-2003” се попълва автоматично от системата или чрез 

използване на помощния списък; 

 Полето „Вид дейност – описание” се попълва автоматично от системата след  

попълване на полето „Код по КИД-2008. 

8.5 Раздел „Други данни ” 

 
Фиг. 41 Изглед на раздел „Други данни” 

В този раздел се въвежда допълнителна информация за местната единица като брой 

заети/наети лица, приходи от продажби, разходи за възнаграждение и др. 
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9. Декларация за предприятие без стопанска 

дейност. 

Страницата „Декларация за предприятие без стопанска дейност” предоставя възможност 

за въвеждане и редактиране на данните от декларацията за предприятие без стопанска 

дейност. 

Страницата се зарежда за конкретно избран отчет (от тип „xxxx-БСД”) от страница 

„Работа с отчети”, чрез избор на препратката Декларация за предприятие без стопанска 

дейност  през 2013 година от списъка със справките в отчета. 

Страницата „Декларация за предприятие без стопанска дейност” съдържа лента с 

командни бутони и страница, които обхваща информацията, съдържаща се в 

декларацията, както следва: 

9.1 Лента с командни бутони 

В горната част на страницата „Справка за предприятие без стопанска дейност” е 

разположена лента с бутони, извършващи необходимите операции по съхраняване на 

данните, отмяна на направените промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 

отчети”; 

При натискане на този бутон системата проверява за извършени промени и ако има 

направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 

промени. Системата извежда съответно предупредително съобщение за извършени 

промени, които не са потвърдени или отменени. В този случай преди да напуснете 

страницата, трябва да вземете решение дали да съхраните или отмените промените, след 

което отново можете да натиснете бутона . 

2) Бутонът  отваря отваря нов прозорец с PDF-бланка, попълнена с 

данните от справката: 

PDF-бланката се използва само за за разпечатване в необходимия формат или съхраняване 

на копие от справката на локалния компютър (като съхраняване може да се извършва само 

за изследванията от ГОД-2012 включително нататък). 

3) Бутонът  съхранява направените от Вас промени, ако има такива; 

4) Бутонът  отменя направените от Вас промени, ако има такива; 

Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 

не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 

въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

5) Бутонът  изпълнява действие „Валидиране” на декларация за 

предприятие без стопанска дейност, при което системата извършва предвидения 

логически контрол за справката; 
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При наличие на проблеми системата ще изведе съобщение с кратко описание на 

констатираните при валидирането проблеми. Възможно е да бъдат констатирани 

проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 

(предупреждения). При наличие на фатални грешки системата маркира справката като 

„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 

маркира справката като „Валидна”. 

9.2 Обща информация за декларация за предприятие без 

стопанска дейност. 

 
Фиг. 42 Изглед на тематична страница „Декларация за предприятие без стопанска дейност” 

 

В тази страница се въвежда и редактира информацията, която се съдържа в декларацията 

за предприятие без стопанска дейност, като се спазват общите принципи за въвеждане и 

редактиране на данни в системата. 
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10. Страница „Справка за група предприятия” 

Страницата „Справка за група предприятия” предоставя възможност за въвеждане и 

редактиране на данните от справка за група предприятия в годишния отчет. 

Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 

избор на препратката Справка за група предприятия през 2013 година от списъка със 

справките в отчета. 

Страницата „Справка за група предприятия” съдържа лента с командни бутони и две 

тематични страници, които обхващат обща информация и данни за отделните членове на 

групата от предприятия, както следва: 

10.1 Лента с командни бутони 

В горната част на страницата „Справка за група предприятия” е разположена лента с 

бутони, извършващи необходимите операции по съхраняване на данните, отмяна на 

направените промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 

отчети”; 

При натискане на този бутон системата проверява за извършени промени и ако има 

направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 

промени. Системата извежда съответно предупредително съобщение за извършени 

промени, които не са потвърдени или отменени. В този случай преди да напуснете 

страницата, трябва да вземете решение дали да съхраните или отмените промените, след 

което отново можете да натиснете бутона . 

2) Бутонът  съхранява направените от Вас промени, ако има такива; 

3) Бутонът  отменя направените от Вас промени, ако има такива; 

Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 

не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 

въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

4) Бутонът  изпълнява действие „Валидиране” на справка за група 

предприятия, при което системата извършва предвидения логически контрол за 

справката; 

При наличие на проблеми системата ще изведе съобщение с кратко описание на 

констатираните при валидирането проблеми. Възможно е да бъдат констатирани 

проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 

(предупреждения). При наличие на фатални грешки системата маркира справката като 

„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 

маркира справката като „Валидна”. 

5) Бутонът  визуализира методологическите указания за попълване на 

справката. 
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6) Бутонът  отваря нов прозорец с PDF-бланка, в която са попълнени и 

форматирани за печат данните от попълнената справка за група предприятия. 

PDF-бланката се използва само за разпечатване в необходимия формат или 

съхраняване на копие от справката на локалния компютър (като съхраняване 

може да се извършва само за изследванията от ГОД-2012 включително нататък). 

10.2 Обща информация за групата от предприятия 

 
Фиг. 43 Изглед на тематична страница „Обща информация за ГП” 

В тази тематична страница се попълва обща информация за групата предприятия (ГП). 

Въвеждането на данните се извършва последователно отгоре надолу. В зависимост от 

избрания отговор на първи въпрос се визуализират полетата, които е желателно да бъдат 

попълнени и се скриват тези, за които не трябва да се въвежда информация. Също така 

втората тематична страница „Членове на ГП” се визуализира и попълва само, ако на 

първи въпрос отговорът е ‘1’ или ‘2’ (т.е. Глава на ГП). При опит за напускане на 

страницата или при натискане на някой от бутоните  или   се 

проверява, дали са попълнени данни в задължителните полета, които се определят според 

отговора на първи въпрос. 
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10.3 Членове на групата от предприятия 

 
Фиг. 44 Изглед на тематична страница „Членове на ГП” 

В тази тематична страница се попълват данни за всяка една правна единица или 

юридическо лице, които са част от групата предприятия. Страницата е достъпна само, ако 

на първи въпрос от „Обща информация за ГП” е отбелязано, че предприятието е глава на 

група предприятия.  

Създаването на нов запис в таблицата се извършва чрез бутона . След натискане на 

бутона новият запис се създава най-отгоре в таблицата. За успешното въвеждане на ред е 

необходимо да бъдат попълнени всички задължителни полета.  Изтриването на вече 

въведен запис в таблицата с данни се осъществява чрез бутона .  

Общият брой въведени редове трябва да съответства на броя, указан във въпрос ‘3.3’ от 

страницата с обща информация за групата. 
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11. Страница „Справка ПРОДКОМ” 

Страницата „Справка ПРОДКОМ” предоставя възможност за въвеждане и редактиране на 

данните от справка за производството и продажбите на промишлени продукти. 

Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 

избор на препратката Справка за производството и продажбите на промишлени продукти 

за 2013 година от списъка със справките в отчета. 

Страницата „Справка ПРОДКОМ” съдържа лента с командни бутони и две тематични 

страници, които обхващат информацията от раздели I, II и III, описани по-долу както 

следва: 

11.1 Лента с командни бутони 

В горната част на страницата „Справка ПРОДКОМ” е разположена лента с бутони, 

извършващи необходимите операции по съхраняване на данните, отмяна на направените 

промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 

отчети”; 

При натискане на този бутон системата проверява за извършени промени и ако има 

направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 

промени. Системата извежда съответно предупредително съобщение за извършени 

промени, които не са потвърдени или отменени. В този случай преди да напуснете 

страницата, трябва да вземете решение дали да съхраните или отмените промените, след 

което отново можете да натиснете бутона . 

2) Бутонът  съхранява направените от Вас промени, ако има такива; 

3) Бутонът  отменя направените от Вас промени, ако има такива; 

Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 

не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 

въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

4) Бутонът  изпълнява действие „Валидиране” на справка 

ПРОДКОМ, при което системата извършва предвидения логически контрол за 

справката; 

При наличие на проблеми системата ще изведе съобщение с кратко описание на 

констатираните при валидирането проблеми. Възможно е да бъдат констатирани 

проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 

(предупреждения). При наличие на фатални грешки системата маркира справката като 

„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 

маркира справката като „Валидна”. 

5) Бутонът  визуализира методологическите указания за попълване на 

справката. 
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6) Бутонът  отваря нов прозорец на браузъра, в който са форматирани за 

печат данните от попълнената ПРОДКОМ справка. 

За да прегледате точно, как ще изглежда справката при отпечатване изберете в браузъра 

меню File>Print Preview. В случай на необходимост може да настроите страниците за 

отпечатване като изберете меню File>Page Setup. Тъй като справката съдържа таблица с 

много колони е препоръчително в Page Setup да изберете опция Landscape.  

11.2 Раздел I 

 
Фиг. 45 Изглед на тематична страница „Раздел I” 

Тематична страница „Раздел I” съдържа таблица, която служи за визуализиране, 

въвеждане и редактиране на данни от „Справка за производството и продажбите на 

промишлени продукти”. За извършване на действия в таблицата се използва лентата с 

бутони в горната й лява част: 

Създаването на нов запис в таблицата се извършва чрез бутона . Новият запис след 

натискането на бутона се създава най-отпред в таблицата. 

Изтриването на вече въведен запис в таблицата с данни за производството и продажбите 

на промишлени продукти се осъществява чрез бутона . 

 

Таблицата позволява търсене и филтриране на визуализираните записи. При натискане на 

бутона  се появява допълнителен ред с полета над всяка колона, където може да се 

зададе критерий, според който да се филтрират записите. В полетата за търсене може да 

се задава и само част от търсенето значение, като тогава се извличат само тези записи, 

чиито стойности в съответните полета започват със зададеното значение. При търсене 

може да се използват и релации от вида „>”, „>=”, „<”, „<=”. Критериите за търсене, 

зададени в няколко полета, се изпълняват с логическо „И”. След задаване на стойности в 

полетата за търсене, филтърът се прилага като се натисне клавиша <Enter>. 
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Пример:  

Търсене на записи, чиито код по ПРОДПРОМ започва с 24.10 и чието „Количество” за 

производство общо е >= 5 000,00 

1) В полето за търсене, което е над колоната „Код по ПРОДПРОМ” напишете 

24.10 (не е необходимо да се ползва маскиращ символ %); 

2) В полето за производство – общо количество напишете >=5000; 

3) Натиснете <Enter>. 

 За да извлечете отново всички записи, трябва да изтриете въведените стойности от 

полетата за търсене и да натиснете клавиша <Enter>. 

 
Фиг. 46 Изглед на таблицата за справка ПРОДКОМ с филтрирани записи според зададения горе критерий 

Тъй като таблицата съдържа много колони, в долната и част има хоризонтален плъзгач, 

чрез който могат да се визуализират всички полета за количество и стойност на 

производството и продажбите на отделните продукти или услуги.   

Данните, които се въвеждат в този раздел, са както следва: 

 В полето „Код по ПРОДПРОМ 2011” се въвежда код от „Номенклатурата на 

промишлената продукция ПРОДПРОМ”. Кодът се въвежда ръчно в необходимия 

формат (например 17.11.13.00) или чрез използване на помощен списък, 

визуализиран след натискане на бутона . След попълване на полето с валиден 

код по ПРОДРОМ, при излизане от полето системата автоматично попълва 

„Наименование на продукта” и „Измерителна единица” (в случай, че има 

дефинирана национална измерителна единица за този елемент). 

Забележка: При избор на продукт от помощния списък със стойности е необходимо да се 

укаже код на икономическа дейност по КИД-2008, за която да се филтрират елементите от 

класификация ПРОДПРОМ. За целта трябва да се напише код на икономическа дейност 

(например 17.11)  и след натискане на клавиша <Tab> се попълва списъка със съответните 

промишлени продукти. Кодът на икономическата дейност може да се укаже и чрез избор 

от помощен списък с икономическите дейности по КИД-2008, визуализиран при 

натискане на бутона до съответното поле. 
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Фиг. 47 Изглед на помощен списък за избор на промишлен продукт 

 Всички полетата за количество и стойност на производството и продажбите се 

въвеждат във формат на дробни числа като се използва символа запетая (,), а не 

точка (.); 

Забележка: В зависимост от типа на продукта и измерителната му единица не се изисква 

въвеждане на количество и стойност за всички полета. В този случай след избор на 

продукт, системата автоматично забранява за въвеждане съответните полета. 

 Полетата за „Продажби (средна цена в левове)” се изчисляват и попълват 

автоматично от системата, като се ползват съответните въведени данни за 

стойност и количество.  
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11.3 Раздел II и III 

 
Фиг. 48 Изглед на тематична страница „Раздел II и III” 

Тематична страница „Раздели II и III” съдържа: 

 Справка за промишлените услуги на ишлеме; 

 Справка за натовареността; 

 Имена и телефон на лицата, отговорни за въведените данни в конкретната 

справка. 

Забележка: Първоначално системата попълва автоматично данните за „Ръководител”, 

„Съставител”, „Лице за контакт” и „Тел. за контакт”. При необходимост за 

конкретната справка тези данни могат да се променят от потребителя. 

 

12. Страница „Справка ПРОДЕНЕРДЖИ“ 

Страницата „Справка ПРОДЕНЕРДЖИ” предоставя възможност за въвеждане и 

редактиране на данните от справка за производството и продажбите на енергийни 

продукти. 

Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 

избор на препратката Справка за производството и продажбите на енергийни продукти за 

2013 година от списъка със справките в отчета. 

Със страницата „Справка ПРОДЕНЕРДЖИ” се работи по аналогичен начин както със 

„Справка ПРОДКОМ“ (виж глава 11. „Страница „Справка ПРОДКОМ” по-горе). 
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13. Приложение: Потребителски интерфейс 

ИС „Бизнес статистика” е реализирана като Web-базирана система. Потребителският 

интерфейс на системата е съчетание от Web-страници и електронни бланки във вид на  

PDF-форми.  

13.1 Web интерфейс 

Във Web-страниците на приложението са използвани различни видове визуални 

компоненти (текстови полета, етикети, combobox-ове, checkbox-ове, таблици и др.) за 

представяне / въвеждане / редактиране на данните. Всяка страница съдържа съвкупност от 

визуални компоненти, обособени в групи. 

Всяко самостоятелно поле в страниците е съчетано с етикет (кратък текст в ляво на 

полето), описващ значението на полето. Когато курсорът е фокусиран в конкретно поле, в 

дясно от полето във вид на tooltip се визуализира по-дълъг текст, описващ значението на 

полето. 

 

Задължителност 

В случай, че дадено поле е задължително за въвеждане, пред етикета на полето е поставен 

символът *, което означава, че данните не могат да бъдат съхранени, ако не е попълнено 

маркираното с този знак поле.  

При определени условия някои полета динамично стават задължителни за въвеждане – в 

този случай полето не е маркирано изрично на екрана със символ, тъй като има случаи, в 

които полето е задължително и случаи, в които не е задължително. При опит да се 

съхранят данните системата визуализира съответното съобщение за непопълнено 

задължително поле или загражда в червена рамка проблемното поле. 

Пример:  

 

 

Ограничения за допустими символи 

В повечето полета трябва да бъде спазен определен формат на въвежданата информация. 

Когато потребителят наруши изисквания формат, при излизане от полето или при опит за 

съхраняване системата загражда с червена рамка проблемните полета или визуализира  

съответни съобщения. Ако на екрана има поле, заградено с червена рамка, можете да 

видите каква е причината за проблема като се позиционирате върху полето, т.е. курсорът 

на текущия фокус трябва да се намира в заградено в червена рамка поле. Когато се 

намирате в проблемно поле, системата визуализира подсказка за това какво е наложеното 

ограничение върху полето, което не сте спазили. 
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Пример: 

 

 

Навигация 

За навигация между полетата в страницата може да се използва клавишът <Tab> или 

мишката. При обхождане с клавиша <Tab> се спазва наредбата на полетата на екрана в 

посока отгоре, отляво-надясно и надолу. При излизане от поле, т.е. преместване на фокуса 

в друго поле, системата извършва валидация на въведената стойност, маркира в червено 

полето, ако има нарушено ограничение и премества фокуса в следващото поле. В този 

случай не се визуализира подсказката на проблемното поле, тъй като фокусът е извън 

него. Ако искате да видите подсказката, трябва да преместите фокуса в проблемното поле. 

Нашите препоръки при въвеждане и промяна на данните в страниците е следната: 

Докато добиете опит в работата със системата използвайте след като сте въвели 

информация в поле клавиша <Enter>, чрез който се извършва валидиране на стойността 

на полето, но фокусът остава в същото поле и веднага се визуализира подсказка, ако има 

нарушено ограничение. Ако полето не се загради с червена рамка или не се визуализира 

съобщение за проблем, тогава въведената информация е коректна и можете да 

продължите в следващото поле.  

 

Компоненти на Web потребителски интерфейс 

В Web-страниците на системата са използвани следните визуални компоненти за 

презентиране на данните: 

 

1) Текстово поле: 

 

Текстовото поле се представя като заграден с тънка черна линия правоъгълник. В площта 

на правоъгълника може да се попълват различни типове данни в зависимост от 

дефиницията на съответното поле. Допустимо е попълването на: 

 Текстови стойности; 

 Числа; 

 Дати. 

В зависимост от данни-типа на полето и допустимия му формат системата може да 

сигнализира на потребителя за недопустими символи или формат. 

 

2) Поле от тип „падащ списък” (combobox): 

 

В този вид полета потребителят има възможност да избере точно един от елементите от 

списъка. 
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3) Поле само за четене: 

 

Това са полета, чието значение се визуализира в страницата като етикет, т.е. статичен 

текст без рамка. Този тип полета не могат да бъдат променяни – за тяхното попълване се 

грижи системата. 

 

4) Поле с помощен списък: 

 

Тези полета са обикновено текстово поле или поле за четене, до което има икона . При 

mouseclick върху иконата се отваря допълнителен прозорец, в който се визуализират 

елементите на свързаната с полето номенклатура: 

Пример: 

 

 

Помощните списъци се използват за намиране на елемент от номенклатура с възможен 

голям брой записи, за чието презентиране не е подходящо поле от тип падащ списък. 

Помощния списък се визуализира в отделен прозорец най-отгоре на страницата. При 

визуализиране на помощен списък страницата, от която е извикан списъкът, става 

недостъпна за работа до затваряне на прозореца на помощния списък. Помощният списък 

съдържа поле за задаване на условие за филтриране, бутон за търсене, таблица с 

намерените резултати и функционални бутони за избор и отказ. 

В полето над таблицата можете да зададете условие за търсене и с помощта на бутона  

да филтрирате елементите, отговарящи на условието. В полето за задаване на условие 

може да напишете само част от търсеното значение на дума. (За подробности виж 6.1 

Секция „Търсене на отчети”). 

От таблицата с намерените резултати изберете конкретен ред (избраният ред се оцветява в 

тъмно син фон) и натиснете бутона „Избери” в долната част на прозореца. Стойностите на 

избраният ред се попълват в свързаното поле от страница, откъдето е извикан помощният 

списък. 

Ако желаете да затворите прозореца без да избирате елемент, натиснете бутона „Отказ”.  

Внимание: Клавишът <Enter> изпълнява действието на бутона “Избери” за текущо 

селектирания ред от таблицата. 
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5) Бутони и препратки 

 

 

Това са компоненти, чрез които се изпълняват специфични за системата програмни 

обработки или се използват за навигиране между страниците в системата. 

 

Внимание: Във всички страници на системата, в които се работи с данни (това са всички 

страници без началната страница и страница „Вход”) НЕ използвайте стандартните 

функции на браузъра (Back, Forward, Refresh, ръчна промяна на URL-адреса и бутончето 

за затваряне в горния десен ъгъл на рамката на прозореца), а използвайте предвидените в 

страниците средства за навигация и препратката „Изход” в горния десен ъгъл на 

страницата. При използване на функциите на браузъра има опасност от загуба на 

последните направени от Вас промени в данните, които не са съхранени, както и от 

заключване на записи с данни в БД. Ако заключите записи с данни, ще трябва да изчакате 

1 час, докато данните Ви се освободят отново за работа. 

Внимание: За визуализиране и работа с електронни PDF-форми (по-голямата част от 

справките в отчета) също се използва браузъра. Всяка PDF-форма се отваря в отделен 

прозорец на браузъра и единственият начин да бъде ЗАТВОРЕНА е чрез бутончето за 

затваряне в горния десен ъгъл на рамката на прозореца (бутончето обозначено с кръстче). 

За повече подробности относно електронните PDF-форми виж следващата точка от 

документа. 

 

Бутоните са представени или като заграден правоъгълник в сив фон с кратко текстово 

значение, или като икона за най-често използваните функции. 

Бутонът  служи за иницииране на операция „Съхраняване на данните в БД”. Всички 

промени, които са направени в данните през страниците на приложението, не се 

съхраняват автоматично в БД. Необходимо е изрично потребителят да стартира действие 

„Съхраняване” и да изчака за потвърждаващо съобщение за успешно изпълнена операция. 

Бутонът служи за иницииране на операция „Отказ от направените промени”. 

Потребителят има възможност да нанесе множество изменения в данните и в даден 

момент да реши да съхрани промените в БД или да се откаже от тях. Този бутон НЕ 

изпълнява действие „Undo” на последната операция. При стартиране на тази операция се 

отменят всички направени промени на данни върху екрана от последното успешно 

съхраняване на данните насам. 
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13.2 PDF-форми 

По-голямата част от справките в годишните отчети са реализирани като електронни PDF-

форми за on-line попълване (само „Справка за предприятието”, „Справка за група 

предприятия”, „Справка ПРОДКОМ“ и „Справка ПРОДЕНЕРДЖИ” са реализирани като 

Web-страници). PDF-формите изцяло наподобяват хартиените формуляри на годишните 

отчети.  

 

Основните типове визуални компоненти в PDF-формите са: 

1) Поле за четене: 

 

Това са полета, в които системата автоматично попълва данни, които се извличат от 

информацията в БД: 

 

2) Текстово поле за въвеждане на данни: 

 

Аналогично на текстовите полета от Web-интерфейса това са полета за въвеждане на 

текст, числа или дати. За всяко поле е дефиниран съответен формат, който трябва да бъде 

спазен. Ако имате включена опция „Highlight Fields” в горния десен ъгъл на toolbar-а на 

Adobe Reader, полетата за въвеждане се оцветяват в светло син фон. В случай, че не е 

разрешено редактиране на справката, всички полета се забраняват за промяна. 

 

3) Помощен списък: 

Аналогично на помощните списъци в Web-интерфейса при необходимост от избор на 

елемент от по-голяма номенклатура в PDF-формите е осигурен помощен списък за избор, 

който се извиква от оцветена в синьо препратка или чрез бутон, оцветен в сиво. Работата с 

помощния списък е подобна на описаната по-горе, като в тези списъци не е осигурен 

механизъм за филтриране. Търсеният елемент се намира визуално и се избира аналогично 

на описаното. 

Пример с препратка: 

 

 

Пример с бутон: 
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Пример за помощен списък: 

 

 

4) Поле с отметка: 

Това са полета с две възможни състояния – включено и изключено: 

 

 

5) Бутони 

Това са компоненти за извършване на програмна обработка с данните в PDF-формата. 

Представляват правоъгълник с черна рамка, оцветен в сив фон, с текстово описание. Във 

всяка PDF-форма в края на справката след всички полета за въвеждане и преди указанията 

са разположени два основни бутона: 

Бутонът  изпълнява действие „Съхраняване” на данните в БД. Всички 

промени, които нанасяте във формата трябва да бъдат съхранени с помощта на този бутон. 

Съхраняването на данните не изпълнява логическите проверки, на които се подлагат 

данните, т.е. можете да съхранявате данните по всяко време, независимо до къде сте 

стигнали с въвеждането. При успешно съхраняване на данните се визуализира съответно 

съобщение.  

Забележка: Съхраняване на данните в БД можете да правите по всяко време, дори и без да 

сте завършили въвеждането на цялата справка. По този начин можете да се предпазите от 

евентуално разпадане на връзката със сървъра и загуба на работата в екрана от последното 

успешно съхраняване насам. 

Забележка: Всички полета от PDF-формите са конфигурирани в базата данни със 

съответен формат, на който трябва да отговарят стойностите им. В PDF-бланката полетата 

също имат дефиниран точен формат за въвеждане. Ако при опит за съхраняване на 

данните системата изведе съобщение, че има форматен проблем с някое поле (например 

въведен е текст в числово поле, а PDF-бланката не Ви е възпрепятствала), то в този случай 

най-вероятно става въпрос за разминаване на конфигурирания формат в БД и този в 

бланката. При подобна ситуация сигнализирайте на посочените адреси за контакт като 

опишете точно проблема и изпратите съобщението за грешка. 
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Бутонът  изпълнява едновременно съхраняване и логическа проверка на 

въведените в справката данни. Валидирането обхваща само логическите проверки, които 

са върху данни само от тази справка. В рамките на целия отчет има заложени също и 

логически проверки между различни справки, които се изпълняват при приключване на 

отчета. Валидирането на дадена справка трябва да се изпълни след като сте преценили, че 

справката е окончателно попълнена. Ако при валидацията на PDF-бланка бъдат 

констатирани проблеми, системата автоматично визуализира диалогов прозорец, 

съдържащ списък на констатираните проблеми. Този диалогов прозорец има само 

информативен характер и след като го прегледате трябва да го затворите, за да 

продължите работата си в справката. Пълният списък на констатираните проблеми при 

валидацията може да намерите в прозореца на браузъра, в който работите с конкретния 

отчет. За да се визуализират в екрана на отчета проблемите на тази справка след нейното 

валидиране, трябва да опресните на екрана данните за отчета (за подробности виж раздел 

6.3.1. „Лента с командни бутони” в глава 6.3. „Секция „Детайли на отчета”). 

Внимание: При работа с PDF-форма не забравяйте да съхраните данните изрично преди 

да затворите прозореца. Прозорец с отворена PDF-форма се затваря с помощта на 

бутончето за затваряне на прозорец, което се намира в горния десен ъгъл на рамката на 

прозореца (бутончето обозначено с кръстче). При затваряне на прозореца системата не 

предупреждава потребителя за извършени промени, които не са съхранени! 
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13.3 Съхраняване на съдържанието на отчети локално на 

компютъра 

Копия на попълнените справки от отчета могат да бъдат съхранявани като файлове 

локално на Вашия компютър. Тази функционалност е налична от началото на 2013 г. за 

новите отчети (отчетите от ГОД-2012 включително нататък). Тази функционалност НЕ е 

налична за по-старите отчети. 

Съхраняването във вид на файл на съдържанието на справка, която е реализирана в 

системата чрез PDF-форма, се извършва чрез бутона Save на Adobe Reader (бутонът с 

дискетката в tollbar-а под заглавието на прозореца, в който е отворена справката):   
 

 
Фиг. 49 Локално съхраняване на справки, реализирани като PDF-форми 

По този начин могат да се съхраняват както справките, реализирани като PDF-форми за 

въвеждане, така и справките, които са реализирани чрез Web-форми за въвеждане, но се 

генерират за разпечатване като PDF-форми (напр. „Справка за предприятието” и 

„Справка за група предприятия”). Останалите справки (тези, които се въвеждат чрез Web-

форма и се генерират за разпечатване във формат HTML, напр. „Справка ПРОДКОМ” и 

„Справка ПРОДЕЖЕРДЖИ”) могат да се съхранят във файл във формат HTML от менюто 

File -> Save As на браузъра. 

Съхраняването се извършва справка по справка, т.е. не може всички справки от отчета да 

се съхранят на локалния компютър наведнъж. 

Важно: Локално съхранените копия на справките НЕ могат да бъдат редактирани и/или 

подавани по-късно към системата (т.е. това не е функционалност за работа в режим off-

line, а е само възможност за поддържане на архив на подадените отчети локално на Вашия 

компютър).  

 



Информационна система „Бизнес статистика” 

 

РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 
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14. Въпроси и проблеми 

При констатиране на проблеми при стартиране на системата, проблеми при работа със 

системата или ако имате допълнителни въпроси, моля обръщайте се към вашите 

Териториални статистически бюра или на следните e-mail адреси: 

 За технически проблеми или въпроси – isbs_tech@nsi.bg  

 За методологически проблеми или въпроси – isbs_stat@nsi.bg 

 


